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1. Getting Started 

Introduction. 
This course covers the 3-Axis functionality available in PowerMILL. The additional features 

available with PowerMILL–Pro and Five Axis licenses are covered in separate modules. 

PowerMILL will quickly create gouge free cutter paths on imported component data. It 

supports Wireframe, Triangle, Surface, and Solid models created by other Delcam products 

or from neutral formats such as IGES. If the relevant PS-Exchange translators are purchased 

PowerMILL will also directly import data created by other of proprietary CAD packages.  

 

Start PowerMILL 
• Double click the relevant PowerMILL shortcut icon on the desktop:  

 

Note:- On the training pc the icon will be displayed as PowerMILL . 

 

The following screen is then displayed: 
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The screen is divided into the following main areas: 

1)  Menu Bar –  

Clicking one of the menu names on this bar (for example, File) opens a pull-down list of 

associated commands and sub-menus. A sub-menu is indicated by a small arrow to the right 

of the text (for example File - Recent Projects >). Highlighting this arrow generates a list of 

commands/names specific to that sub-menu (for example, File - Recent Projects displays a 

list of recently opened projects that will open directly when clicked). 

2)   Main Toolbar –  

This provides quick access to the most commonly used commands in PowerMILL. 

3)  Explorer –  

The Explorer provides control options and storage of PowerMILL entities 

created during the session. 

4)  Graphics Window – This is the large, visual display area to the right of the 

Explorer (Look at the illustration on previous page). 

5)  View Toolbar –  

Provides quick access to standard view and shading options in PowerMILL 

6)  Information Toolbar - 

 

This area provides a reminder of some of the active setup options. 

Tool Toolbar - facilitates the rapid creation of tools in PowerMILL. 

The other toolbars are not factory defaults, and are therefore not shown at initial startup. To 

display any of these, select using the relevant option under View - Toolbar, for example 

View - Toolbar - Toolpath to display the Toolpath Toolbar:  
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To change the background colour of the graphics area, select Tools - Customise Colours and 

select View Background.  The Top and/or Bottom colours can be changed independently 

and Reset using Restore Defaults to restore to the original settings:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PowerMILL remembers Toolbar and colour selections from one session to the next, for 

example, if the Toolpath Toolbar is open when the session is closed, it will appear the next 

time that PowerMILL is opened. 

Mouse buttons 
Each of the three mouse buttons perform a different dynamic operation in PowerMILL.  

Mouse button 1: Picking and selecting 
 

This button is used for selecting items off the pull down menus, 

options within forms, and entities in the graphics area. 

The method of selection is controlled by 2 options accessed from the 

Viewing toolbar the default being ‘Select using a Box’ 

 

 

 

Select using a box   
 

If the cursor is positioned on an entity, such as part of a surface model and the left mouse 

key is pressed, then the item will turn yellow signifying that it has been selected.  

 

If the same process is applied to another surface, all currently selected items will be de-

selected.  

  

If the Shift key is held down during the process then the new selection will be added to the 

original selection.  

 

If the Ctrl key is held down while clicking on a surface it will be removed from the total 

selection. 
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Select by dragging the cursor    
 

If this option is selected then multiple, selection of entities will occur by simply dragging the 

cursor across the required items. This is ideal for quick selection areas of the model 

consisting of multiple surfaces. To deselect the Ctrl key is depressed while dragging across 

an entity. 

 

Mouse button 2: Dynamics 
 

Zooming in and out: - Hold down the CTRL key and mouse 

button 2. Move the mouse up and down to zoom in and out. 

Pan around the model: -Hold down the SHIFT key with mouse 

button 2. Move the mouse in the required direction. 

Zoom Box – hold down the Ctrl and shift key, drag a box around 

the area to zoom into using the middle mouse button. 

Rotate mode: Hold down mouse button 2 and move the mouse, 

and the rotation is centered about the trackerball.  

 
View Spinning- Dynamically rotate the view and quickly release the mouse. The faster the 

mouse movement, the faster it will spin. This feature is switched off by default. 

 

• Select Tools -> Options - View - 3D Graphics and tick the option Spin 
View. 

 

 

 

 

 

 

 

 
 

 

Mouse button 3: Special Menus & PowerMILL Explorer Options 
 

 

When this button is pressed it brings up a local menu relating to 

whatever the mouse is over, such as a named item in the 

PowerMILL Explorer or a physical entity in the graphics area. 

If nothing specific is selected the View menu appears.  
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HELP! 
PowerMill provides the user with help in a number of ways: 

  

  

1.      Tooltips. Place the mouse cursor over a menu button. A box will appear containing 

a description of what that button does. 

  

2.      Online Help. Select Help>Contents… from the Main Toolbar, to access the 

online help documents.  There is a full index and search facility provided. 

  

3.      Context Sensitive Help. Pressing the F1 key will display the help page for the 

currently active form. Clicking on the    button in the top right hand corner of the 

form, followed by a left click in any of the input fields will focus on the help topic 

for that part of the form. 

  

4.      PowerMill User Forum. On any PowerMill PC with an Internet connection, 

selecting Help from the main toolbar, followed by Visit the User Forum, will 

enable you to participate in web based user discussions on PowerMILL issues. The 

forum can also be accessed from any other internet connection by going to 

http://forum.delcam.com/ 

  

5. Telephone and Email Support. UK customers with up-to-date software 

maintenance can call 01216831010 or mail support@delcam.com to get help or 

advice on specific application problems.  

 

 

PowerMILL contains On-Line Help the main access being via the Help tab on the main 

pulldown menus.  

 

 

 
 
 

• Select Help -> What’s New. 
 
 
 
 
 
 

 
 
 
A summary of all the new functionality available in the current version of PowerMILL is 

loaded into the html pane. 



1. Getting Started                                                                     PowerMILL 2011 

1.6 Issue PMILL 2011   

Simplified PowerMILL Example  
 

This example provides a quick overview of the machining process. It shows how to create 

and output a couple of simple toolpaths on a model of a valve chamber (using default settings 

wherever possible). 

The basic procedure is: 

1. Start PowerMILL. 

2. Import a Model. 

3. Define the Block from which the part will be cut. 

4. Define the cutting Tools to be used. 

5. Define Set up options (Rapid Move Heights – Start and End Point). 

6. Create a Roughing Strategy. 

7. Create a Finishing Strategy. 

8. Animate and Simulate the toolpaths. 

9. Create an NCProgram and output as a post-processed ncdata file. 

10. Save the PowerMILL Project to an external directory. 

     Import a Model    
                                                                             

• From the main pulldown menus select, File - Import Model and browse 
for the model file:-  

           D:\users\\training\ PowerMILL_Data\Models\PmillGettingStarted.dgk.  
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Blanking of Model entities 

This provides the user with a quick and simple way to control which individual, model 

entities are displayed. In the illustrations below, the light blue surfaces are selected. 

If one or more surfaces are selected they can temporarily be removed from the graphics area 

by using the Blank Selected option (Ctrl J) in the local Model menu (accessed by right 

clicking on a surface). 

 
 

 

 

 

 

 

 

If one or more surfaces are selected all others can be removed from the graphics area by 

using the Blank Except option (Ctrl K) in the local menu. 

The 2 selected items are light blue. 

 

 

 

 

 

 

To return all Blanked items back to the graphics are the Unblank option (Ctrl L) is selected 

in the Default menu (accessed by right clicking in the graphics area).The Blanked items are 

returned to the graphics area and become selected (back to the left hand image above). 

 

Also accessed form the Default menu is the Blank Toggle option (Ctrl Y) which if selected 

will switch the Blanked and Unblanked items to the other status. 
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Definition of the Block 
 

 

• Click on the Block icon              on the top toolbar. 
 
 
 
The Block Form is used to define the 3D 

working limits. This could be the actual 

raw material size or a user defined volume, 

localised to a particular part of the 

component.  

 

 

The Block Form default is Defined by - 

Box around the model dimensions on 

clicking the Calculate button. Individual 

values in the form can be edited or locked 

(greyed out) as required in addition to 

being calculated to include an offset by 

entering a suitable value in the box marked 

Expansion. 

 

 

 

 

 

 

 

 

 

 

• Click on the Calculate button.  

• Click on Accept. 
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Cutting Tool definition 
 

The Tool definition forms are accessed from the icons accessed from the Tool toolbar 

located to the bottom left corner of the graphics area.  

 For use with this example, 2 tools will be created, A Tip Radiused for roughing out and a 

Ball Nosed for finishing. 

 

• Click on the down arrow to display all of the Create Tool icons.  
 

All of the tool types appear as icons. 

 

 

 

 

 

Placing the cursor over an icon will open a small box containing a description of 

the tool type (Tool tips). Note the unavailable, greyed out tool definition icons 

are only available in PowerMILL Pro. 

 

 

 

 

 

 

 

 

• Select the Create a Tip Radiused tool icon.  
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Safe Z 

Start Z 

Rapid 
 

Plunge 
 

Cutting 

The Tip Radiused Tool form opens ready for the user to input the required values. When a 

diameter value is input the tool length automatically defaults to five times this value. This 

value can be edited if required.                            

It is highly recommended to input a more appropriate Name for the tool. In this case the tool 

has been renamed as Name D12t1. 

If appropriate, a specified Tool Number can be output to the NC program. If the machine has 

a tool changer this number will represent the location in the carousel. 

 

 

• Enter a Diameter of 12 a Tip Radius of 1. 

• Enter D12t1 in the box marked Name before Clicking on Close. 
 

• Repeat the Tool Definition operation, this time selecting ‘Create a Ball 
Nosed tool’ and in the form entering a Diameter 12 with a Tool Number 2 
before  and enter the name BN12 before Clicking on Close. 

• In the explorer panel on the left of the screen, open the tools and right 
mouse click on the D12t1 tool to raise the local menu. Select Activate.  

 

Only one tool can be Active at any one time and the 

word Activate in the local menu will be prefixed with a 

tick. the active tool will automatically be included in the 

form when a machining strategy option is opened. 

In the explorer, the Active tool will be displayed in bold 

text and prefixed with ‘> ‘.     

Rapid Move Heights 
 

The Rapid move heights form is essential to allow the user to safely control rapid tool 

movements across the component.  Safe Z is the height above the job at which the tool can 

move at rapid feedrate, clear  of any obstructions such as the workpeice or clamps. Start Z is 

the height to which the tool will descend, at rapid feed rate prior to applying the plunge feed 

rate. PowerMill displays rapid moves as dotted red lines, plunge as pale blue and cutting as 

green. 
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• Click on the Rapid Move Heights icon. 

• In the resultant form select the Calculate button. 

• Click on Accept. 
 
This will automatically set absolute SafeZ and 

Start Z values to be above the block by the 

distance in the incremental height fields shown at 

the bottom of the form. 

An Absolute setting will always cause the tool to 

feed down from the same height.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tool Start and End Point. 
 

• Click on the Tool Start and End Point icon.  
 

The Start and End Point form allows the user to 

define a position where the tool travels to before and 

after a machining strategy. By default the tool Start 

Point is set at Block Centre Safe and the End Point 

is set to Last Point Safe.  

 

 

 

 

 

 

 

 

 

Other Start and End Point definitions are achieved 

by selecting different options in the Method area on 

the form. 

These include Block Centre Safe, First/Last Point 

Safe, First/Last Point, and Absolute. 
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• Accept the form with the default settings. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The D12t1 tool is positioned at the Block Centre Safe position ready for the user to create 

the first toolpath. 

Creating a Roughing Strategy 
 

•  From the Main toolbar select the Toolpath Strategies icon. 
 
 
 

• Select the 3D Area Clearance tab. 
 
 
 
 
 
 
 
 
 

• Select the option Model AreaClear Model to open the form shown on the 
following page. 
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• Input the new Name D12t1-a1 for the toolpath that will be created.    
 

 
 

• Select Style 
Raster. 

 

• Edit the 
Thickness 
value to 0.5. 
This is the 
amount of 
material that 
will be left on 
the job 

 

• Edit the 
Stepover value 
to 10. This is 
the distance 
between each 
raster pass (the 
width of cut). 

 

• The Stepdown 
value (depth of 
cut) is left at the 
default of 5. 

 
 

• Click the Calculate tab to process the machining strategy. 
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The resultant 3D Raster Area Clearance can be simulated as follows:  

 

• Raise the Simulation Toolbar by selecting View>Toolbar>Simulation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• From the Simulation Toolbar, select toolpath D12t1-a1 in the first field and then click 

the Play button to initiate the simulation. 

 

 

 

 

 

 

     

               

 

The other buttons on this toolbar can be used to rewind or step through the simulation. 

 

                

 

 

 

NB. The above strategy has been processed almost completely using the default values, the 

exceptions being the Name, Thickness and Stepover. 
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Creating a Finishing Strategy 
 

• In the explorer right mouse click on the BN12 tool and in the local menu 
select Activate (or double left mouse click on the tool’s explorer icon).  

• From the Main toolbar select the Toolpath Strategies icon. 
 
 
 

• Select the Finishing Tab. 
 
 
 
 
 
 
 
 
 

• Select the option Raster Finishing follwed by OK to open the following 
form. 

 
 

• Input Name 
BN12-a1 

 
 
 
 
 
 
 
 
 
 
 
 

• Edit the 
Stepover 
value to 1.0 

 

• Click the 
Calculate tab 
to process the 
machining 
strategy. 
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The Raster 

Finishing pattern is 

projected down Z 

onto the component 

taking into account 

tool geometry and 

machining settings. 

Note:- The toolpath 

link moves, clear of 

the job are not 

displayed in this 

illustration for 

clarity. 

 
 
 
 

Toolpath Simulation and ViewMILL 
 

PowerMill provides two stages of options for simulating toolpaths. The first simulates the 

cutting tool as it progresses along the toolpath. The second also includes a shaded image of 

the stock material being reduced as the tool progresses along the toolpath. 

 

1 – Toolpath Simulation 
 

• In the explorer right mouse click on the roughing toolpath D12t1-a1 and 
from the pop-up menu click Activate to make the toolpath active (ticked). 

 
 
 
Note: The Active toolpath is displayed in bold text and 

prefixed with a > symbol. 

 

 

• In the explorer right mouse click on the roughing toolpath D12t1-a1 again 
and from the menu click Simulate from start.   
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• The Toolpath Simulation toolbar will be displayed at the top of the screen. 
This displays the name of the toolpath and tool, together with buttons to 
control the simulation. 

 
The operations performed by each of the buttons are as follows:-  

   Play - starts the simulation and plays it in continuous mode. 

  Pause - pauses the simulation. 

 Step Back - steps the simulation back by tool moves.  Click the Play button to 

resume continuous mode. 

 Step Forward - steps the simulation by tool moves. The faster the speed (defined 

using  Speed Control) the bigger the step. Click the Step Forward button 

again to see the next move or click the Play button to resume continuous mode. 

  Search Backward - steps the simulation back to the previous toolpath segment. 

Go to End - moves to the end of the toolpath. 

  Search Forward - steps the simulation to the next toolpath segment. Click the 

Search Forward button again to see the next component or click the Play button to 

resume continuous mode. 

 Go to Beginning - moves to the start of the toolpath. 

   Go to End - moves to the end of the toolpath. 

  Speed Control - controls the speed of the simulation. The fastest setting 

is by having the slider at the right, the slowest at the left. 

 

 

 

 

NB. Resting the mouse pointer over any button will also raise a tool-tip describing the button 

function. 

• Simulate the toolpath by clicking on the Play button.  

• Activate the finishing toolpath BN12-a1 and repeat the simulation 
process. 

• Unload the toolpath when complete. 
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2 – ViewMILL 
 

• Activate roughing toolpath D12t1-a1 and select it in the simulation 
toolbar. 

• Raise the ViewMILL toolbar by selecting View>Toolbars>ViewMILL from 
the top toolbar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
The ViewMILL toolbar will be displayed, although initially all the icons will be greyed out. 

 

 
 

• Click the first button    to Toggle ViewMILL Window and enter 
ViewMILL mode. 

 
The ViewMILL toolbar icons will become active (highlighted). 

 

 
 

Click the fourth button   to select a plain shaded image.  
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• Select the tool icon  to display the tool followed by the Play icon . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In ViewMILL the machining of the material block is simulated as shown above. 

• When the above simulation is finished, in the Simulation Toolbar, select 

the  finishing toolpath BN12-a1 followed by the tool icon .  

• Select Play icon  again,  to view the continued simulation of material 
removal by the finishing toolpath. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Simulation toolbar select the ViewMILL Exit icon  to exit the 
ViewMILL session. 
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NC Programs (Post-Processing and Ncdata Output) 
 

• In the main pull down menus select Tools - Customise Paths to open the 
PowerMILL Paths form (shown below right). 

 
 
 
 
 
 
 
 
 
 

• In the Powermill Paths form select the option NC Programs Output. 
 

 
 
 
 
 

 
This controls where the post-processed, 

ncdata files are output ready for 

download to a machine tool controller. 

 
 
 
 
 

• Right mouse click the Add path to top of list icon and in the Select Path 
form browse to the required location C:\temp\NCPrograms and select OK. 

 

• In the explorer right mouse click over NC Programs to open the following 
sub-menu. 

 
 
 
 
NC Preferences enable the user to control the content of 

output files for download to a Machine Tool.  
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• In the NC Programs sub-menu select Preferences to open the following 
form. 

 
 
 
The Output Folder 

defaults to the location 

already defined in Tools- 

Customise Paths. 

 
 
 
 
 
 
 
 

 

• In the above form click on the Machine Option File icon (arrowed) and in 
the resultant form select heid400.opt before clicking Open. 

 
 
        
 
 
 
 
 
 
 
 
 
 
 

• On return to the NC Preferences form select the Apply tab to action the 
settings and then Accept the form. 

• In the explorer right mouse click over NC Programs and from the sub-
menu select Create NC Program.  

 
 
An empty NC Program will appear in the 

explorer ready to have machining strategies 

assigned to it. The NC Program form will 

also open in the Graphics area. 
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• In the explorer move the cursor over the toolpath D12t1-a1 and while 
holding down the left mouse key drag a ghosted image onto the NC 
Program named 1. 
 

Note:-  Alternatively, Right mouse click on toolpath D12t1-a1 and from the local menu, 

select Add to > NC Program.  

 
 
 

A copy of the toolpath name will appear in the NC 

Program indicating that it has been assigned as part of the 

output file. 

 
 

• In the explorer drag a copy of the finishing toolpath name BN12-a1 onto 
the NC Program named 1 and click on the small, adjacent boxed plus sign. 

 
 
The toolpath names are listed in the NC Program 

ready to be post-processed. 

 
 
 
 
 

 

• In the NC Program form displayed in the graphics area, select the Write 
tab to start the post processing operation. The following Information form 
will open providing the user with a progress and confirmation summary. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Close both the NC Program and Information forms and using the 
windows explorer move to C:\temp\NCPrograms and note the existence 
of the ncdata output file 1.tap.                   
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Saving the Project 
 

• Left mouse Click on the 2nd icon along the Main toolbar to open the Save 
Project As form. 

 
 
 
 

 
 
 
 
If the Project has been Saved before then the Project will be updated without the following 

form being opened.  

 
• Select File - Save Project As:-        
         C:\users\training\COURSEWORK\PowerMILL-Profects\GettingStarted-1 

 

• Left mouse click in the Save tab to store the Project to a named external 
directory (the form will close automatically). 

• In the Main toolbar select File – Delete All followed by Tools – Reset 
Forms.  

 
The content of the explorer will be deleted and all forms will be reinstated to factory, default 

settings. The externally stored copy of the Project (GettingStarted-1) can be reopened as 

required. 

Additional Exercise 
 

• Import the model facia.dgk located in the Examples directory. 
         
 
 
 
 
 
 
 
 
 

 

• Save the Project as:- 
           C:\users\training\COURSEWORK\PowerMILL_Projects\Facia-1  

• Use the same Tooling and create similar machining Strategies to those 
created in GettingStarted_1. 

• Once completed and the Project finally Saved, select File - Delete All 
followed by Tools - Reset Forms.  
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2. Machining Setup in Detail 

Additional Preparation before creating toolpaths 
 

In the previous section the toolpaths were created using the default values wherever possible. 

We will now look at the machining process in more detail. 

In particular: 

Setting up direct access to regularly used files 

Repositioning of the component to a suitable alignment for machining 

Detail Examination model features 

Tool and Holder definition 

Material Block Definition 

Safe Z Heights 

Setting up direct access to regularly used folders 
 
To Import a Model the user can select File > Import Model from the top pulldown menu. A 

selection of sample model files are supplied and installed from within PowerMILL in a 

default directory called Examples.  

 

 

These are directly accessed via the icon in the Import Model form.  

Alternatively, regularly used models can be accessed quickly with the user definable buttons              

 and                        on the Import Model form.    

 

 

 

• From the Main pulldown menus select Tools - Customise Paths. 
 

 

 

 

 

 

 

 

 

 

 

• Select the option File Dialog Button 1 
followed by the Add path to top of list icon 

 and browse to:-    
                     C:\users\training\PowerMILL_Data\Models 
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• Repeat the last process, but this time set File Dialog Button 2 to provide 
direct access to:- 

                                C:\users\training \PowerMILL_Data 

 
Note:- Outside the training environment the location of the PowerMILL_Data directory will 

depend on where the user has installed it! 

Loading a Model into PowerMILL 
 

• From the Main pulldown menus select File - Import Model. 

• Use Shortcut Button 1 or browse to:-     
               C:\users\training\PowerMILL_Data\Models 

 
 
 
 

Note: A variety of different types of Model 

format can be imported into PowerMILL. 

These can easily be discriminated on the 

form using the filter Files of type to widen 

or narrow the choice for file extension. 

 

 

• Click on the file name speaker_core.dgk and then select the Open. 

• Select View from top (Z)   followed by Resize to fit    from the 
Viewing toolbar to the right of the graphics area. 

 

 

The model will be displayed (as shown) in the PowerMILL 

graphics area looking down the Z-axis with X aligned from left to 

right and Y from bottom to top. 

In most cases the X dimension of a machine tool table will be 

greater than Y in which case the longer side of the component may 

be in excess of the travel limits in Y. 

 If this is the case it will be necessary to align the component with 

the longest side along X to ensure that it can be positioned within 

the travel limits. 

Saving the Project 
It is good practice to create a Project as soon as possible and then to update (Save) it at 

regular intervals both manually and automatically. 

 

• From File select Save Project As:- 
 
         C:\users\training\COURSEWORK\PowerMILL-Projects\Spkr_Core 
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Viewing the Model 
Although the model is displayed it is a good idea to look at it from all angles to fully 

understand its size and features. 

 

• Select an isometric ISO 1 view.    
 

Although it is possible to rotate the actual component 

this is not generally regarded as the ideal approach. 

An additional moveable datum (Workplane) will be 

created and rotated through 90 Degrees to effectively 

create the condition that the longer side of the component 

is parallel with the front of the machine. 

The original coordinate set-up can then easily be re-

activated for tasks such as checking dimensions.  

 

Orienting the Model – creating the machining datum using a 
Workplane 
 

A Workplane will be created and rotated through 90 degrees about Z to effectively arrange 

the longest lower front edge of the model to be aligned to the front of the machine tool i.e. 

along the X-axis. 

 

• Select the whole model by dragging a box over it while the left mouse 
key is depressed. 

• Right click over Workplanes in the PowerMILL explorer and select:- 
Create and Orientate Workplane > Workplane at top of Selection 

 
 

Workplanes are additional 

datums that can be moved 

and/or orientated within the 

global environment. One 

Workplane can be Active at 

any one time. If no 

Workplanes are active then 

the original global Transform 

is the datum. 

 

 

A Workplane will appear at the top centre of the selected model components. 

 

The new Workplane will also be registered in the PowerMILL explorer. For easy 

identification it is recommended to Rename entities created in the explorer with something 

relevant to their application. 

 

• In the PowerMILL explorer right mouse click on the actual workplane and 
from the local menu select Rename. 
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• In the form change the default Name to Datum. 

• Right mouse click on the new Workplane named Datum and select 
Activate from the local menu. 

• From the same local menu select Workplane Editor to open the 
Workplane editing toolbar. 

 
 
 
 

The next step will be to rotate the new Active Workplane to indirectly re-orientate the model 

such that the longer side is aligned to the X-Axis.  

 

• Select the Twist about Z icon. 
 

 

 

 

• Enter Angle 90.0 before selecting Accept. 

• Select the Green Tick on the toolbar to finally 
accept the changes. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Select a View from top (Z) to see the effect of the rotated, Active 
Workplane providing a more suitable machining position for the model. 

 
It will not always be necessary to create and rotate or move a Workplane after import into 

PowerMILL. It depends on the original, orientation of the model when exported from the 

CAD software. 
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Examination of Model Properties 
 

Information regarding the model dimensions in relation to the world datum (Transform) or 

(if present), an Active Workplane can be obtained. 

 

• In the explorer Right click over Models and select Properties. 
 

 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If required, the values in this form can be copied (Ctrl C) and then pasted (Ctrl V) into 

other forms (Such as to modify the position of a Workplane). 

 

 

 

 

 

 

 

 

• Eject the Model Properties form by clicking X in the top right corner of the 
form. 

• Select a Y- view. 
 

 
 
 
The Workplane is shown 

positioned on the top of the 

model, which has the longer 

edge aligned to X. 
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Minimum Radius and Draft Angle shading views 
 

Visual checks can be made quickly with the use of two shading options found in the views 

menu on the right hand side of the screen. 

It is useful to know before generating tools and toolpaths what the minimum radius is on the 

model and also whether there are any undercuts or draft angles. 

 

 

 

 

 

• Open the Shading Toolbar by clicking the small arrow in the bottom right 
corner of the main icon, as shown above. 

 

• Select the Minimum Radius Shade icon on the toolbar.  
 
 
 
Any internal radii that are smaller than the specified Minimum Tool Radius will be shaded 

RED. The settings are located in the explorer - Model pull down menu in Drawing 

Options. 

Examine the model to identify areas that are inaccessible to the specified radius (shaded 

Red). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The two internal radii can be seen shaded red visually identifying that they will not be 

machined to their correct size if the default value tool was used. 

 

 

 

The specified Minimum Tool Radius can be modified to suit in the Drawing Options area 

within the Models menu in the explorer. 
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• In the explorer Right click over Models and select Drawing Options. 
 
 
 

 

 

 

 

 

 

 

 

 

• Change the Minimum Tool Radius value to 5. 
 
The shading on some parts of the model has changed from Red to Green signifying that from 

a finishing viewpoint these local areas are fully accessible to a Dia 10 Ball Nose cutter. 

 

• Change the Minimum Tool Radius value to 2. 
 
All of the red areas have now disappeared which suggests that the maximum tool size 

guaranteed to access all areas of the component would be a Dia 4 Ball Nose cutter. 

The model can also be visually inspected for the size of draft angles and undercuts. 

 

• Select the Draft Angle Shade icon on the shading toolbar.  
 

The model is shaded in three different colours, red, green and yellow. 

The red areas represent angles equal to or less than the current Draft Angle specified in the 

Drawing Options form (default is 0). 

The green areas represent angles above the current Warning Angle specified in the Drawing 

Options form (default is 5). 

The yellow areas represent the areas between the current Draft Angle and Warning Angle. 

On this particular model the yellow areas represent angles between 0 and 5 degrees. 

 

• To check for undercuts change the Draft Angle to -0.2 and the Warning 
Angle to 0.2. 

 
All of the red areas have disappeared and all that remain are green and yellow. If any red 

areas remain then these would indicate an undercut situation greater than –0.2 degrees. 

The yellow areas indicate on or near vertical faces because the difference between the Draft 

and Warning Angles is so small.  

 

• Accept the Drawing Options form 
 

• Select the Draft Angle Shade icon          again to turn off the shading.  

• Make sure the Wireframe  icon from the View toolbar is on so the 
model is displayed in Wireframe only. 
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Measuring the model 
 

The user may require dimensional information relating to certain features on the model. A 

measuring tool is provided in PowerMILL that allows the user to snap in the graphics area to 

obtain dimensions based on points, lines and arcs. 

Before any such measurements can be taken the PowerMILL, Snap Filter will need to be 

modified. 

 

• From the top Pull Down menus select Tools > Snap Filter and use the left 
mouse key to untick - Anywhere. 

 
 
 
If Anywhere is unticked then measurements can be only be 

snapped onto the remaining ticked entities and not in free space. 

 

 
 
 
 

• Zoom into the area shown by the arrow below. 
 

We 

The gap at the bottom of the slot will be measured to determine its size and depth. Note that it 

is essential to Zoom in close to be able to discriminate the close proximity node points. 

 

 
 

• From the Main toolbar select the Measure model icon.  
 
The Model Measurement for appears defaulted to Line. An Anchor Point is required to 

commence measuring. 

 

• The PowerMILL Calculator form will open in Line measurement mode. 
Using the left mouse button drag a window around (or snap) point 1 shown 
below to display the XYZ coordinates in the form. 
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Drag a window around (or snap) point 1. 

 
 
 
 
 
 

 

 

 

 

 

The Anchor Point is now selected and is 

represented by a small circle. 

The x, y and z values seen in the above 

form are relative to the Active Workplane 

‘Datum’. 

 

• Drag a window around (or snap) point 2 to obtain the final ‘point to point’ 
measurement information. 

 
A temporary line appears connecting the two points, and the information relating to the line is 

displayed in the form. 

Minimum Radius is measured via the Circle tab combined with snapping three points on the 

model. 

 

• Select the Circle tab on the Model Measurement form and zoom into the 
area shown below. 

 
 

 

• Select three points along the arc either by dragging a small window 
around, or snapping onto each one as shown below. 

 
 



2. Machining Set up in Detail                                                                    PowerMILL 2011 

2.10 Issue PMILL 2011   

 

 

 

 

 

 

 

 

 

 

 

 

A temporary circle will appear after the third point is selected as shown above. 

 

 

 

 

 

 

 

 

The Circle measurement form will display 

details of the arc as shown. 

 

 

 

 

 

 

• Close the Model Measurement form. 
 

PowerMILL Panes 
 

On the left hand side of the screen above the explorer are the 

PowerMILL panes. 

 

 

The standard format pane is denoted by the PowerMILL symbol 

and contains the explorer tree categorised into NC 

Programs,Toolpaths, Tools, Boundaries, Patterns, Feature Sets, 

Workplanes, etc. 

 

 

 

The second pane is the HTML browser used for viewing HTML files 

or Help files and the third pane opens the PowerMILL Recycle Bin. 
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Setting Feedrates 
 

Feedrates can be set individually for the current tool and toolpath or loaded from a database 

of predefined values. At this stage we will look at setting the feedrate individually. The Tool 

Database will be covered later in the course. 

 

• Click the Feeds and Speeds icon  on the top toolbar to raise the Feeds 
and Speeds form. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Cutting Conditions section of the form, enter a Spindle Speed of 
1200 and a Cutting Feed Rate of 400 (as shown above). 

• Accept the form. 
 

• Select Save Project to update the content of the externally stored Spkr-
Core folder (Do not close). 
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Tool and Holder Definition 
 

• Open the Tip Radiused tool form. 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

• In the (above) default Tip form define a Dia 50 Tiprad 6 - Length 125 - 
Named D50T6 - Tool Number 6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Shank form, click the Add a shank component icon and enter 
Upper/Lower Diameter 50 and Length 125. 
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The Overhang is the 

vertical distance from the 

bottom of the holder to the 

tip of the cutter. 

 
 
 
 
 
 
 

 

• In the Holder form, click the Add holder component icon entering Upper 
Diameter 120 - Lower Diameter 80 - Length 125 and Overhang 250. 

• In the Holder form, click the Add holder component icon entering an 
Upper/Lower Diameter 120 and Length 100. 

• Close the form 
 
The style in which the tool is displayed can be controlled by right clicking on TOOLS in the 

tree browser pane and selecting Shaded. 
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Material Block Definition 
 

• Calculate a 3D working volume (Block) to actual model dimensions using 
the Defined by - Box option. 

 
 
The default option for Block is Box (A rectangular 

volume). Other options include Cylinder (a 

Cylindrical volume), a Triangle model (Casting) 

available in PowerMILL PRO only, and 

Picture/Boundary (Extruded 2D wireframe 

contours).  

 
 
 
The dimensions of the Block can be entered 

manually or calculated directly to the Type of 

entity:- 

Model, Boundary, Pattern, or Feature. 

 
The Opacity slider controls the degree of shading 

(clear to dense). 

 

Rapid Move Heights 
 

• In the Rapid Move Heights form click the Calculate tab to set the default 
values for tool rapid moves to clear the component by 10. 

 
 
 

• Input the active Workplane Datum. 
 
The Rapid Move Heights options enable safe rapid 

moves between tool tracks clear of the top of the 

Component or Block (whichever is the higher).  
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Start and End Point  
 

• In the Start and End Point form use the default settings :- 
    Start Point - Block Centre Safe and End Point - Last Point Safe. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save Project 
 

• Select Save Project to update the saved PowerMILL Project (Do not 
close the Project). 

 
Note: The Project is stored in:-   

C:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core 

 

Up to PowerMILL 9 it has been the responsibility of the user to Save the Project at suitable 

times during the PowerMILL process. In addition to this, Tools - Options - Projects can be 

set to include Save the Project automatically either on calculation of each toolpath or after a 

set time period (or both). From PowerMILLL 10, if one or both is set, then even if a Project 

has not been created the session will now auto recover after a crash. 

 

• In the main Pull Down menus select:- 
 Tools - Options - Projects - Auto Save Project 

 

 

 

 

 

 

 

 

• Input Minutes Between Auto Saving as 30 (minutes) and tick the Save 
on Calculation Box. 

 
PowerMILL will now automatically apply Save Project after a toolpath has calculated as 

well as every time 30 minutes has elapsed since the previous Save Project.  
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Toolpath Processing Options  

Calculate 
Once a machining strategy has all the required settings and values ready for processing, the 

Calculate tab can be clicked to start the calculation process. During this time the user is 

unable to continue working in PowerMILL until the Toolpath has been created. In this case 

the strategy form remains open with just the Recycle and Copy options active. 

 

 

 

 

There however two further options:- 

 

Queue (PowerMILL PRO users only) 
The second is Queue that allows the user to continue working in PowerMILL while the 

Toolpath is being processed in the background. (One or more Strategies can be added to the 

Queue and they are calculated in the background, in sequential order). As soon as a strategy 

is applied to the Queue the form closes. 

 

 

 

 

 

Note; The ‘Calculator’ symbol changes to the 

‘Queue’ symbol as soon as the Queue option is 

selected. 

 

Queue can either be applied directly from within 

a Strategy form, or from the explorer menu (as 

shown left). 

 

OK - Batch Process 
The third is OK which closes the unprocessed, toolpath form with the current settings and 

values, stored and ready for the Batch Process, menu option to be applied. One or more 

unprocessed, machining strategy can be saved to be sequentially calculated later, on selection 

of the Batch Process option. While Batch Processing in taking place the user is unable to 

continue working in PowerMILL until all the included Toolpaths have been created. 
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3.  3D Area Clearance 

Introduction 
The main strategies for roughing a 3D component Model are called 3D Area Clearance. 

These provide a choice of 2D material removal methods, which progressively machine the 

area (Slice), up to the component contour, down a sequence of user-defined Z Heights.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sometimes known as Waterline Roughing the cutter steps down to a specified Z Height and 

fully clears an area (Slice) before stepping down to the next Z Height to repeat the process. 

 

 

 

 

 

 

 

 

 

 

 

For some components a secondary Area Clearance strategy is applied using the Rest 

Machining options in conjunction with a smaller roughing tool. This will locally remove 

pockets of excess material inaccessible to the original Reference Toolpath or Stock Model. 

This will reduce the degree of tool overload and provide a more consistent material removal 

rate for any subsequent Finishing operations.   

 

If the original material is in the form of a casting or fabrication then it may not be necessary 

to apply any Area Clearance machining but to go directly for a semi-Finishing strategy. 
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Thickness and Tolerance (Applied to 3D Area Clearance) 
 

Suitable values are required to control the accuracy and amount of excess material to be left 

on a component by a toolpath. The parameters used for this purpose are preset and are called 

Thickness and Tolerance.  

 

Thickness is the amount of extra material specified to remain on the work-piece after 

machining. This can be applied generally (as shown), or independently as separate Radial 

and Axial values within the machining options.  

 

Raster Area Clear example 
The Raster Area Clear strategy follows a series of linear moves across the Block limiting to 

the Component form at the active Z height. It then, (if required) performs a Profile pass 

around the component to leave a constant thickness around the Slice. Other options provide 

the abilty to further fine tune the final strategy. 

 

• From the Main toolbar select the Toolpath Strategies icon. 

• Select 3D Area Clearance tab. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

• Select the option Model Area Clearance to open the following form. 
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• Enter the Toolpath 
Name D50T6_A1 

 

• Set Thickness to 0.5 
 

• Set Stepover to 20 
 
 

• Set Stepdown to 10 
 

 

• Keeping all other 
values as default, 
Calculate the form. 

 

•  After the processing is 
complete Cancel the 
form. 

 
 
 
 

 
 

 

As soon as the Raster Area Clearance (Model) form is 

opened an unprocessed Toolpath appears in the Explorer (the 

default name has been changed to D50T6_A1).  

 

 

The Toolpath icon 

can be double-

clicked to Activate 

and de-activate the 

toolpath. 

The + symbol can 

be clicked to open a 

full record of the 

data used to create 

the toolpath. 

The dotted red lines 

represent Rapid 

moves and the light 

blue lines are the 

Plunge feed moves.  
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Rapid Move Heights in detail 
The Rapid Move Heights form provides Safe Z and Start Z input boxes. Suitable values are 

entered to define a safe height (Safe Z) at which a tool can safely perform, horizontal Rapid 

Moves above the model as well as (Start Z) where a Rapid plunge move changes to a 

plunge Feed Rate. If the Reset to Safe Heights tab is clicked then PowerMILL will set the 

Safe Z and Start Z to be a safe distance above the Top of the Model or Block (whichever is 

the highest).  

 

Rapid Move Heights works in conjunction with the Leads and Links form  which in 

turn provides a more flexible choice of toolpath Link moves. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Safe (default) sets the plunge feed rate to apply at a specific height above the job. This is 

more predictable and reassuring for the machine tool operator but the time take by the non-

cutting (air) moves is inefficient especially in the case of large, deep components.  

In the section of the form labelled Incremental Heights, in addition to Safe, two other 

options Skim and Incremental are available. 
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Skim enables the downward, rapid feed rate to continue to a specified Incremental Start Z 

above the full plunge depth before the slow plunge feed rate ‘cuts in’. Skim then applies a 

rapid retract to an Incremental Safe Z above the highest point on the component ‘in line’ 

with a linear link move to the next plunge position. To cater for all types of machine tool 

this move is a (Purple) Skim Feed Rate (G1) as instead of a (Dashed red) Rapid (G0).  

 

 

 

 

 

 

 

 

 

 

 

 
Incremental applies the rapid feed rate all the way down to an Incremental Start Z 

measured from the full plunge depth at which point the slow plunge feed rate ‘cuts in’. The 

Plunge option differs from Skim in that all rapid link moves occur at the Absolute Safe Z. 

Feed Rates assigned to Toolpath element colour 
The Feeds and Speeds form uses the Style and Colour of elements along a toolpath to 

register the correct type of Rapid Move or Feed Rate settings.  

 

                 Fixed (G0) Rapid moves:-     Red Dashed - Toolpath elements   

 

 Variable (G1) Feed Rate moves:- 

 

Green/Orange - Toolpath Cutting Feed moves. 

Pale Blue - Toolpath Plunging Feed moves. 

Purple - Toolpath Skim Feed moves. 

 

Also, local areas of a toolpath can be assigned with 

additional Cutting Feed Rate values via the 

Toolpath Editing options (See Chapter 8) as a 

percentage of the nominal value. PowerMILL will 

assign a different colour to areas of the toolpath 

edited to have a new Feed Rate.  
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• From the Main toolbar, select Feeds and Speeds  and input the 
values shown above before selecting Accept. 

• Right mouse click over the Toolpath icon in the explorer to open the local 
pull down menu. 

 
 
 
 
 
 
Note the toolpath can also be activated or 

deactivated from the Activate switch in the 

pulldown menu.  

 

 

• Select Settings to reopen the Raster AreaClear Model form. 

• Select the ‘make a copy’  of the toolpath icon. 
 
 
On the left of the Model Area Clearance form is an 

explorer window. When an individual option relating to the 

strategy is selected all related settings etc are exclusively 

displayed in the main form. This makes it easier for the user 

to navigate, with the minimum settings on the form at any 

one time along with larger tabs and icons. 

 

 
 
 
 
 
 
 

• From the Toolpath form explorer select the Links option and change the 
Short, Long, and Default Links to Skim as shown below. 

 
 
 
 
 
 
 
 

• Select the Calculate tab at bottom left the Model Area Clearance form 
and once processing is complete click Cancel to close the form.  
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The tool will now plunge 

locally (pale blue move) from 

the defined Incremental - 

Start Z relative to each slice 

and rapid across the roughed 

areas using an Incremental - 

Safe Z (purple move). 

 
 
 
 
 
 
 

Statistics 
Provides the user with essential information about the Active toolpath and associated 

parameters. 

 

• Right mouse click on the original toolpath (D50T6_A1) in the PowerMILL 
explorer and from the local menu select Activate. 

• In the same menu select Statistics and a form will open displaying 
information relating to the toolpath and associated settings. 

 
 
 
 
 
 
 
 

 
 

 
 
 
 

Note; In this case the total machining time is displayed as 12:35 hrs.  

•  Activate the second toolpath (D50T6_A1_1) and obtain the Statistics. 

Note: In this case the total machining time will be around 5:12 hrs.  

This large saving is achieved simply by using Skim in the Rapid Move Heights form. In the 

original toolpath Absolute was used in the Rapid Move Heights form and this includes a 

large amount of toolpath link moves running in fresh air. 
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Simulating the toolpath 
 

• Perform both a toolpath and ViewMILL simulation on the final Raster 
Area Clearance toolpath. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Switch the ViewMILL to No Image  to return to the PowerMILL 

session and toggle the ViewMILL On/Suspend  to red (Suspend).  
 
Note:-By toggling back to PowerMILL, the ViewMILL session will still exist in the 

background so that any subsequent toolpaths can later be used to continue the simulation. 

If the Viewmill session is still set to On, then even though it is set to No Image, the 

Viewmill simulation will continue to update parallel with any further, toolpath simulations. 

Saving the Project 
 

• From the Main pull down menus, select File - Save Project to update the 
stored data.  

 

The Project (C:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core) has 

now been updated to include the 3D Area Clearance toolpaths. 

 

• Do Not Close the Project as it is to be continued in the next example. 
 

Offset All – Model Area Clearance example 
 
The Offset All strategy starts by following the contour of the both the Block and Component 

form at the active Z height. It then progressively offsets into the remaining areas of stock. 
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• From the Main toolbar select the Toolpath Strategies icon. 

• Select 3D Area Clearance tab. 
 
 
 

 

 

 

 

 

 

 

 

• Select the option Model Area Clearance to open the following form. 
 

• Enter the Name 
D50T6_A2. 

 

• Select Style – Offset 
All 

 

• Set Thickness to 0.5 
 

• Set Stepover to 20 
 
 

• Set Stepdown to 10 
 

 

• Keeping all other 
values as default, 
Calculate the form. 

 

•  After the processing 
is complete Cancel 
the form. 

 

 
 
 

 

 

As soon as the Offset Area Clearance (Model) form is opened 

an unprocessed Toolpath appears in the Explorer (the default 

name has been changed to D50T6_A2).  
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• Perform both a toolpath and ViewMILL simulation on the final Raster 
Area Clearance toolpath. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select the ViewMILL Suspend icon  and No Image  to return to 
the PowerMILL session. 

 

• From the Main pull down menus, select File - Save Project to update the 
stored data.  

 
The Project (C:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core) has 

now been updated to include the 3D Area Clearance toolpaths. 

 

• From the Main pull down menus select File - Delete All 

• From the Main pull down menus select Tools - Reset Forms 
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Area Clearance – Unsafe Segment Removal 
This option is designed to filter out machining of confined areas that would involve small 

movement of the cutting tool.  In the following example it is applied to prevent a relatively 

large tool attempting to plunge into a deep pocket area where a smaller tool would be a better 

choice.  

 

• Open the ‘Read Only’ Project:- 
C:\users\training\PowerMILL_Data\Projects\MountingBlock-Start 

• Save Project As:- 
C:\users\training\COURSEWORK\PowerMILL-Projects\MountingBlock 

• Activate the Toolpath named No-AreaFilter 
 
 
 
 
 
 
 
 
 
The existing toolpath is allowing 

the cutter to machine into confined 

areas. This is resulting in sudden 

sharp changes of cutting direction 

and excess loading on the tool. 

 
 

• Right click on the toolpath named No-AreaFilter and from the local menu 
select Settings to open the original Offset Area Clearance form. 

• Select the ‘make a copy’ of the toolpath.  

• Rename the copy of the toolpath as AreaFilter. 

• From the toolpath form explorer, select Unsafe segment removal and 
input the settings as shown below (Note; Only remove segments from 
enclosed areas is unticked). 

 
 
 
 
 
 
 
 

All tooltracks spanning a distance less than the Tool Diameter (TDU) will be filtered out and 

not appear in the final Toolpath. 

The effect of unticking Only Remove segments from enclosed areas means that the 

recessed areas running out to the Block will be included in the filtering process.                              
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• Calculate the Offset Area Clear Model form and once processing is 
complete click Cancel to close the form. 

 
 

Area Filter has been applied to prevent the 

cutter attempting to machine into confined 

areas. 

There are however a couple of undesirable 

spikes on the unfiltered part of the toolpath. 

These can be reduced by applying the High 

Speed - Profile Smoothing option. 

 

 

 

 

• Right click on the toolpath named AreaFilter and from the local menu 
select Settings to open the original Offset Area Clearance form. 

• Select the ‘make a copy’ of the toolpath icon (shown arrowed below). 
 
 
 
 

• Rename the copy of the toolpath as AreaFilter-ProfileSmooth. 

• Keep the same Unsafe Segment Removal settings switched on, and in 
High Speed, tick the Profile Smoothing box with the Radius (tool 
diameter units) slider set to 0.2 

 

 

 

 

 
 
 
 
 
 

• Calculate the Offset Area 
Clear Model form and once 
processing is complete click 
Cancel to close the form. 

 
 

 

 

 

 

 

The previously sharp corners around the toolpath outer profile have now been smoothed. 



PowerMILL 2011                                                   3. 3DArea Clearance 

                                                                Issue PMILL 2011                                                                            3.13 

• From the Main pull down menus, select File - Save Project to update the 
stored data.  

 

The Project (C:\users\training\COURSEWORK\PowerMILL-Projects\MountingBlock) 

has now been updated to include the 3D Area Clearance toolpaths. 

 

• From the Main toolbar select File - Delete All. 

• From the Main toolbar select Tools - Reset Forms. 
 

Model Rest Area Clearance example 
 

It is generally good practice to use as larger diameter tool as possible for the initial Area 

Clearance operation. This ensures that the maximum amount of material is removed as 

quickly as possible. In many cases however the larger diameter tool may not have full access 

to certain internal corners or pockets within the component. As a result these areas will 

require further roughing out with one or more, smaller diameter tool before sufficient 

material is removed prior to running the Finish Machining strategies. 

In the Model Rest Area Clearance options a smaller diameter tool is referenced to a 

previously created machining strategy such that tool tracks will only be produced locally 

within the remaining material (stock).   

 

• Import the model:-   
C:\users\training\PowerMILL_Data\models\ WingMirrorDie.dgk 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Create a Tip Radiused tool of Dia 40 tiprad 6 and Name d40t6. 

• From the Main toolbar open the Block form and Calculate using the 
Defined by - Box to the full model dimensions. 

• Calculate the Rapid Move Heights. 

• In the Start and End Point form set the Start Point to Block Centre Safe 
and the End Point to Last Point Safe. 
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• From the Main toolbar select the Toolpath Strategies icon         . 

• In 3D Area Clearance select the option Model Area Clearance to open 
the following form. 

 

• Enter Name D40T6_D1. 

• Select Style - Offset all 

• From the explorer -  
Leads and Links, select 
Lead In. 

                    
 
                 
                    
 

• In the Lead in window 
select 1st Choice - Ramp 

• Select Ramp Options:- 
 
 
 
 
 
 
 
 
 
 
 

 

• Click Calculate to process the above specified Area Clearance toolpath. 
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The Offset all - Area Clearance 

strategy follows both the contours of 

both the Model and Block then 

gradually offsets into the remaining 

material at each Z Height.  

 
 
 

 
 
 

• Right mouse click on the toolpath and select Simulate from Start to 
open the Simulation toolbar. 

 

 

 

• Ensure that the Viewmill toolbar is also active. 
 
 
 

• Switch the ViewMill On/Suspend icon from red  to green   on the 

ViewMill Toolbar, followed by the Shiny Shaded image icon . 
 

 
 

• Press the Play button to start the simulation. 
 

The simulation of the toolpath will start with tool displayed, but this can be controlled by 

toggling the light bulb on the tool entity in the explorer pane. 

 

 
 

Note: Undrawing the tool will speed up the simulation. 
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The finished result indicates that the current tool has not been able to remove enough material 

from some areas of the model.  

As a result a further Area Clearance strategy is required using a smaller tool to continue 

locally into the remaining areas. 

This technique is known as Rest Machining. 

 

• Suspend ViewMill   

• Switch off the shaded image.    
 

Rest Roughing using a Reference Toolpath 
 

• Create a Tip Radiused tool of Dia 16, tiprad 3 and name D16t3. 

• Right mouse click over the Toolpath icon in the explorer. 
 
 
 
 

• Select Settings to reopen the Model 
Area Clearance form.  

 
 
 
 

• Select the ‘make a copy of the toolpath’ icon . 
 
Note: All settings originally used to create the toolpath will become re-activated. 

 

• Activate the new tool, D16t3. 
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•  Enter a new name 
D16T3_D1. 

 
 
 
 
 
 
 
 
 
 
 
• Enter:-   Thickness 0.5       

                       Stepover 1.0          

                       Stepdown 5.0 

 

• Tick the box labelled 
Rest machining to 
display the Rest option 
in the explorer.  

 
 
 
 

• Select the Rest 
Machining type as 
Toolpath and enter 
D40T6_D1 as the 
reference item 

 
 
 
 

 

• In the explorer select 
Unsafe segment 
removal. 

• Untick Remove 
segments smaller 
than threshold. 

 

• Select Calculate to create the additional Offset Area Clear toolpath 
shown on the following page. 

• Cancel the form. 



3. 3D Area Clearance                                                                     PowerMILL 2011 

3.18 Issue PMILL 2011   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Save Project as:-  
  C:\users\training\COURSEWORK\PowerMILL-Projects\Wing_Mirror_Die.  

• Turn ViewMill On (Green)           . 

• Select the Rainbow Shaded Image  . 
 

• Select the toolpath D16t3_D1 and Play the simulation. 
 

 
 
The ViewMILL simulation 

shows this next toolpath 

shaded in a different colour 

where it has machined in 

areas the previous toolpath 

did not cover 

 

The Reference Toolpath has 

roughed out material closer 

to the component form. 

This will reduce the risk of 

excessive wear or damage to 

tools used for the subsequent 

finishing operations.  

 

 

• Select the Suspend ViewMill icon to return to PowerMILL. 

• From the Main toolbar select File - Delete All 

• From the Main toolbar select Tools - Reset Forms. 
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EXERCISE:-  

Area Clearance with both Unsafe Segment Removal 
and Rest Roughing 
• Import the Model:-  
               C:\users\training\PowerMILL_Data\Models\Cowling 
 

Machining Set Up 
• Create the following Tools:-  
     Dia 20 tiprad 3 named D20t3 
     Dia 12 tiprad 1 named D12t1 

• Create and position a Workplane centrally positioned to the top centre of 
the model as a more suitable machining datum. 

• Define a suitable Block using Defined by - Box to Type - Model. 

• Apply Calculate in the Rapid Move Heights form. 
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Area Clearance Strategies 
• Create an Offset All - Model Area Clearance strategy using the Unsafe 

segment removal options to prevent the D20t3 tool from attempting to 
machine into the central pocket. Use a Thickness of 0.5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Create another Offset All - Model Area Clearance strategy this time with 
the D12t1 tool.  

• Before calculation switch off the Unsafe segment removal option and 
switch on the Rest Machining options switched on, referenced to the 
previous toolpath. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Save Project As:- 
 C:\users\training\COURSEWORK\PowerMILL_Projects\ModelAreaClear-Exercise 
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ViewMILL Simulation 
• Perform a ViewMILL simulation on both of the Model Area Clearance 

toolpaths with the Rainbow shading option active. This will enable the user 
to see exactly where the second toolpath (different colour) is removing 
further material from the partially machined block. 

 
 

The Rainbow 

ViewMILL Shading 
option displays the 

resultant material 

removal for each 

toolpath as a different 

colour. 

 
 
 
 
 
 

• From the Main pull down menus select File - Delete All. 

• From the Main pull down menus select Tools - Reset Forms. 
 
 

General information on Area Clearance Machining 
The following is reference information for the many different options contained in the Area 

Clearance form. This can also be found by using Help. 

Thickness 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clicking the Thickness button on the Area Clearance forms opens the Axial Thickness box 

allowing the user to set separate values for Radial and Axial thickness. This faclity is also 

available on the finishing forms. 
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Z Heights – Manual Input 
If Stepdown is set to Manual on the Model Area Clearance form the Area Clearance Z 

Heights form will open. In here are five alternative Defined by options:-  Z Heights:-   

Number, Stepdown, Value, Intermediate and Flat. 

 

Number - divides the block equally into the defined number of Z Heights.  

 

Stepdown - creates a Z Height at the base of the Block and then steps upwards using a fixed 

incremental value. If active the Tick Box - Constant Stepdown causes the distance between 

all levels to remain constant. To achieve this, the actual stepdown value will more than likely 

have to be automatically, modified to be less than the nominal value. 

 
Value - creates a single Z Height at the defined value.  

 

Flat - Identifies flat areas of the model and creates a Z height (+ thickness) at these values. 

It can also be set to machine the specific flat areas instead of the whole of the slice.  

 

Intermediate - adds a specified number of Z Heights between the current ones. 

 

Appending Z Heights - Z Heights can be also be cloned from an existing Model Area 

Clearance toolpath from the Reference section of the Area Clearance Z Height form. 

.  

Profiling  
A profile can be performed at each level to remove steps that will be left by the cutter Before, 

During, or After a Raster - Model Area Clearance strategy. Additional profile passes can be 

applied when machining either on either Every Z, or the Last Z level with Offset, Profile or 

Raster strategies.  

 

When  

This option is in the Raster form accessed from Model Area Clearance explorer. It allows 

the user to determine when the profiling pass occurs during machining.  

 

 None    – No Profiling pass is performed 

 Before – The Profiling pass is performed before the Raster path. 

 During – The Profiling is performed at suitable intervals during the Raster path       

 After    – The Profiling pass is performed last. 

 

Cut Direction  

This controls the direction of the tool along the toolpath:-  

Any – This instructs the cutter to machine in both directions.  

Climb – This will instruct the cutter to profile such that the material is to the right of 

the direction of travel (Climb Milling). 

Conventional – This will the cutter to profile such that the material is to the left of 

the direction of travel (Conventional Milling). 
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Wall Finishing 
This option is accessed from the Wall Finishing Page in the Model Area Clearance 

explorer. It allows the user to make an additional, final profiling pass to further reduce tool 

wear. 

Allow tool outside block 
The Allow tool outside block switch is located in the Limit page Of the Model Area 

Clearance form 

This enables the first pass of an Area Clearnace strategy to be performed to the specified 

Stepover,     rather than the full radius of the tool. 

 

 Flat Machining  
The Flat Machining page of the Model Area Clearance form contains options to control if 

and how the flat areas of a component are machined. These include Off, Area, and Level. 

If Level is selected Flat Machining will occur across the whole area defined by the Block. 

The nominal Stepdown value will be locally reduced as required to accommodate each Flat 

areas as part of an equally spaced, group.  

If Area is selected Flat Machining will be confined to the individuall Flat areas. Note: The 

nominal Stepdown value will remain constant (independant of the Flat areas).  

 

 

Ramping  
This option is accessed via the Leads and Links form down to be applied where it is 

impossible to approach from outside the Block at the full machining depth (eg within a 

pocket). 

 

 
The Zig angle is the angle of descent 

along the machining direction as the 

tool ramps into the material. There are 

3 different types of ramp move 

following the geometry of the 

Toolpath, a Circle, or a Line. If the 

length of the Zig angle is limited to a 

finite distance a ramp move in the 

opposite direction (Zag angle) can also 

be applied. 

 

The Ramp Length is defined as ‘Tool Diameter Units’ (TDU). For example, A Ramp 

Length of 2 TDU would equal 20mm for a Dia 10mm tool.  

If Approach Outside is set, this will take priority over Ramping. 

 

If the defined geometry for a Ramp move is such that it would cause a gouge, then the tool 

will approach using a default, Plunge move. 

 

Ramp Length 

Zig angle 

Zag angle 

Tool 
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Machining Flats 
The area clearance strategies in PowerMILL have an option that allows the user to control 

the way in which flat areas of the model are rough machined. These are found on the area 

clearance form under Machine Flats. 

 

• Import the model:- 
              C:\users\training\PowerMILL_Data\Models\Flats.dgk 

 
 
 
 

• Create a 12mm diameter 
End Mill tool named EM12 

• Calculate the Block using 
the default settings. 

• Set the Rapid Move 
Heights and check 
Start/End Point is set to 
default; Start Point - 
Block Centre Safe and 
End Point - Last Point 
Safe. 

 
 

• From the Strategy Selector - 3D Area Clearance options, select Model 
Area Clearance. 

• Fill in the form exactly as below. 
 
 

• Name:-      
EM12-Flats 

 
 
 
 
 
 
 
 
 
 
 

• Thickness 0.5 

• Stepover 5 
 

• Stepdown 1 
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• In the Model Area 
Clearance explorer 
select the Flat 
machining options.  

 

• Set Machine flats to Off. 
 
 

• Select Calculate to process the toolpath and then Cancel the form 
 

 

With Machine flats - Off the 

toolpath has totally ignored 

the flat surfaces of the model. 

It has maintained the defined, 

Stepdown value and 

performed area clearance 

across the material Block at 

each Z Height. 

 

 

 

• Right mouse click over the Active toolpath and in the local menu select 
Settings.  

• Select make a Copy of the toolpath. 

• Change the Flat machining option to LEVEL (This is the default). 

• Change the toolpath name to EM12-Flats_Level. 

• Calculate to process the toolpath and then Cancel the form. 
 

 

 

 

The Model Area 

Clearance toolpath now 

removes material across the 

whole block area leaving 

0.6mm stock above each 

Flat face (The thickness 

plus the tolerance).  
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• Right mouse click over the Active toolpath and in the local menu select 
Settings.  

• Select make a Copy of the toolpath. 

• Change the Flat machining option to AREA. 

• Change the Name to EM12-Flats_Area. 

• Calculate to process the toolpath and then Cancel the form. 
 
 

The Model Area Clearance 

toolpath now removes material 

locally across each Flat face leaving 

0.6mm stock (The thickness plus 

the tolerance).  

 

 

 

 

 

 

 

 

 

 

• Save Project as:-   
     C:\users\training\COURSEWORK\PowerMILL-Projects\AreaClearFlats 
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PowerMILL Entity Recycler 
• In the explorer Right click over Toolpaths and select Delete All from the 

local menu. 

• Use the same method to Delete All - Models (Do not apply to the Tools 
section in the explorer). 

 

• From the Main pulldown menus select:-  
     Tools - Reset Forms.   
 

 

This restores the factory (default) settings in the forms without having to exit and re-enter 

PowerMILL.  

 

Note: The Model and Toolpaths deleted from the explorer can at this stage be recovered as 

they have been transferred to the PowerMILL Entity Recycler. If File - Delete All is applied 

from the main pulldown menus all items by-pass the Entity Recycler and as a result cannot 

be recovered. Note: Certain items such as Stock Models cannot be transferred to the Entity 

Recycler. 

 

• Left mouse click on the Entity Recycler pane to open the Entity Recycler. 
 

 

 

 

 

 

 

 

• Right mouse click over an item in the Entity Recycler to view the local 
menu options to Recover or permanently Delete an item. 

• Recover a Toolpath from the Recycle Bin and check that it has been 
reinstated in the Toolpaths section of the PowerMILL explorer.  

• Return to the PowerMILL explorer and if necessary, apply Delete All 
separately again on Toolpaths and Models. (Do not apply to the Tools 
section in the explorer). 

 
 
 
 
 
 
 



3. 3D Area Clearance                                                                     PowerMILL 2011 

3.28 Issue PMILL 2011   

PRO - 3D Area Clearance 

Introduction 
Projects Similar to those saved earlier during the (basic) PowerMill part of the course will 

be continued using previously unavailable options, exclusive to PowerMILL Pro. 

 

 

Rest Machining using a Stock Model 
 
An alternative method of Rest Machining is the use of a Stock Model instead of a 

Reference Toolpath.  

The benefits of using a Stock Model compared to a Reference Toolpath are: 

 

• The remaining surplus material can be visualised and registered along with the 

associated toolpaths.  

• A Rest machining strategy referenced to a Stock Model will account for all 

previous operations registered in that Stock Model. 

• A Rest machining strategy created to different Workplane (eg Multi Axis) can be 

referenced to a Stock Model. (Note: It is not possible to apply a Rest machining 

strategy referenced to a Toolpath that was created to a different Workplane). 

 

The following example will demonstrate the creation of a Stock Model up to the end of the 

toolpath D40T6_D1 at which point it will be displayed as the Rest Material. The Rest 

machining toolpath D16T3_D1 will then be used as the basis for creating a new toolpath but 

this time using the Stock Model.  

 

• Open the Project:-  
               C:\users\training \PowerMILL_Data\Projects\WingMirrorDiePro_Start. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Select OK in the 
PowerMILL Warning form. 
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• Save Project As:-   
     C:\users\training\COURSEWORK\PowerMILL-Projects\WingMirrorDie 

 

• In the PowerMILL explorer, Activate the toolpath D40T6_D1. 
 
 

 

 

 

 

• In the PowerMILL explorer right mouse click Stock Models to open the 
local menu and select Create Stock Model. 

 
 
 
 
 
 
 
 
 

• In the PowerMILL explorer right mouse click the newly created Stock 
Model icon and from the local menu select Apply - Active Toolpath 
First. 

 
 
 

 

 

 

 

 

 

 

 

• From the same menu select Calculate to create the Stock Model as 
shown below. 
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• From the same menu again select Show Rest Material to display the 
Stock Model as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• From the same menu again select Drawing Options - Shaded to display 
the Stock Model as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

• In the PowerMILL explorer - Activate the toolpath D16T3_D1. 

• Right click the D16T3_D1 toolpath icon and from the local menu select 
Settings to reopen the Model rest area clearance form. 

• Select the ‘Copy toolpath’ icon (shown arrowed below). 
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• In the local form’s explorer select the Rest option and change the settings 
to use Stock Model  - 1 as shown below. 

                                             
 
 
 
 
 
 
 
 
 
 
 
 

• Click Calculate to create an alternative (more efficient) Rest Machining 
toolpath named D16T3_D1_1. 

• Cancel the Offset Area Clearance Form to reveal the following toolpath. 
 
 

 

Although the Stock Model has been 

used to define the machining limits, 

the new toolpath is not 

automatically added to the Stock 

Model. This is carried out as a 

second operation if required. 

 

 

 

 

 

• Right click over the active toolpath, D16T3_D1_1 in the PowerMILL 
explorer and select Add to - Stock Model. 

 

 

It is also possible to right mouse click on the 

named, Stock Model in the PowerMILL 

explorer and select   Apply - Active Toolpath 

Last. At this stage the Stock Model will 

disappear from the screen. 

 

• Right click over the named, Stock 
Model in the PowerMILL explorer 
and select Calculate to create the 
updated Stock Model as shown. 
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• From the Main toolbar select File - Save Project to update the Project:-    
C:\users\training\COURSEWORK\PowerMILL-Projects\WingMirrorDie  
 

• Delete all entities in the PowerMILL explorer except the D16T3 tool. 

Offset Area Clearance – Offset Type Model 
 

This variant of the Offset Area Clearance is mainly designed for High Speed machining. It 

provides a very consistent tool loading at the expense of an increased number of rapid, air 

moves across the component. This strategy if applied correctly will dramatically help to 

minimise wear to both the tooling and machine. 

The strategy is based on the profile around the component at each Z Height being continually 

offset outwards to be trimmed to the limits of the material Block.  

 

• Save Project As:- 
      C:\users\training\COURSEWORK\PowerMILL_Projects\Handle 

• Import the model:- 
      C:\users\training\PowerMILL_Data\models\Handle.dgk  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the explorer - Activate the Dia 16 tiprad 3 tool D16T3. 

• From the Main toolbar open the Block form and Calculate a material 
Block to the full model dimensions. Lock the Z max and Z min values, 
enter an Expansion value of 10 and Calculate again. 
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• In the Rapid Move Heights , click Calculate.  

• From the Main toolbar click on the Strategy Selector.  

• From 3D Area Clearance select the option Model Area Clearance to 
open the following form then enter data in the main form exactly as shown 
below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Model Area Clearance form select Stepdown - Manual and click 

on the Z Heights icon  to open the Area Clearance Z Heights form. 
 

• In the Area Clearance Z Heights form input Defined by - value - 3.0 and 
then select Calculate (Note: If Z Heights already exist, Delete them by 
clicking the blue cross located to the lower right of the form). 

 

• Close the Area Clearance Z Heights form and then in the main Model 
Area Clearance form select Calculate to process the toolpath.  
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Note: The toolpath is shown with 

the Leads and Links undrawn. 

 

 

 

 

 

 

• Select an Iso 1 view as shown and right click over the toolpath icon in the 
PowerMILL explorer to open the local menu. 

• Select Simulate from Start and in the Simulation toolbar select Play  
to observe the toolpath being run (If required, select the Esc key to stop 
the simulation). 

 
The tool will continuously climb mill, 

starting each tool track a distance from 

the material block to allow the tool to 

reach optimum Feed Rate before 

contact. Each pass will benefit from 

having a consistent material removal 

rate. The strategy can be further 

improved using advanced settings to 

progressively smooth away sharp 

corners and straighten tool tracks as 

they offset further away from the 

component form.  

 

 

• Right mouse click over the Active, D16T2-hsm toolpath icon in the 
explorer to open the local pull down menu. 

• Select Settings to reopen the Offset AreaClear Model form. 

• Select the ‘Copy toolpath’ icon (shown arrowed below). 
 

 

 

 

 

 

 

 

• With the Model Area Clearance form open again, select High speed from 
the local explorer options. 
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• Tick and set Profile smoothing to the maximum slider value of 0.2 (TDU). 
 

• Tick the Smoothing allowance option and set the slider value to 25 (%). 
 

• Click Calculate to create a new toolpath d16t3_hsm1_1 with the improved 
25% smoothing allowance added. 

 
 
 

Compare both of the Model Area 

Clearance  toolpaths noting the 

progressive straightening of tool tracks 

on the second strategy (25% smoothing 

applied). 

 

 

 

 

• From the Main toolbar select File - Delete All to delete all data from the 
current project.  

 
 

• From the Main toolbar select Tools 
     Reset Forms  
 

 

 

 

This restores the original PowerMILL settings in the forms without having to Close and 

restart. 
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Machining Flats 
In PowerMILL Pro it is possible to locally Area Clear machine the flat areas to their exact 

height. This allows the user to rough the part first using Machine Flats set to OFF and then 

clear the flats in a second operation. 

 

• Open the Project:- 
       C:\users\training\PowerMill_Data\Projects\AreaClearFlats_Start 

 
 
 
 
 
 
 
 
 
 

• Select OK in the PowerMILL Warning form. 

• Save Project As:-   
     C:\users\training\ COURSEWORK\PowerMILL-Projects\AreaClearFlats_Example 

 

• Right mouse click on the toolpath FlatsArea and from the local menu, 
select Activate to reinstate all settings and parameters used.  

• From the Main toolbar click on the Toolpath Strategies.  

• From the 3D Area Clearance options select Slice Area Clearance. 
 
 
 
 
 

• Set Slices as 
Flat. 

• Set Offset all. 
 
 
 
 

• Set Tolerance 
0.02 

• Set Thickness 0 
 
 

• Set Stepover 5 
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• In the local explorer select Flat machining. 
 
 
 
 

 

 

 

 

 

• Tick Allow tool 
outside flat. 

 

 

 

 

• Select Calculate to process the toolpath and then Cancel the form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Area Clearance now creates only the Flat areas. 

At the moment the cutter profiles around the edge of the holes. If preferred the strategy can 

be changed to Ignore Holes causing the tool to pass straight over them. 

 

 

• Right mouse click on the Active toolpath and select Settings to re-open 
the Slice Area Clearance form. 

•  Select make a Copy of the toolpath. 
 

• In the Slice Area Clearance form, local explorer select Flat machining. 
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• Tick the box next to 
Ignore holes. 

 
 

The Threshold in TDU (tool diameter units) informs PowerMILL the maximum size of holes 

to ignore. With the tool EM12 selected and the Threshold set to 2, PowerMILL will only 

ignore holes that are less than Dia 24mm. 

 

• Select Calculate to process the toolpath and then Cancel the form. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The cutter now passes across the top of the holes without lifting, producing a smoother 

toolpath. Note that Ignore Holes refers to the slice definition at the top of the holes. The flat 

base of any hole will still be machined. 

If there is a large amount of material remaining on the top of the flat areas, then several 

passes at different heights can be made to reduce the tool loading during the Area Clearance. 

 

• Right mouse click on the Active toolpath and select Settings to re-open 
the Slice Area Clearance form. 

•  Select make a Copy of the toolpath. 
 

• In the Slice Area Clearance form, local explorer select Flat machining. 
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• Tick Multiple 
cuts with 
Number of 
cuts as 3  

 

• Set Stepdown 
as 2.0 

 

• Tick Final 
stepdown with 
the value 1.0 

 
 

• Select Calculate to process the toolpath and then Cancel the form. 
 
 
 
 
 
Note the ‘D’ shaped Flat area at the very 

top level is not using Multiple Cuts as 

the top of the Block is the overall Z limit 

for the strategy. 

 

 

 

 

 

 

 

 

Flat Tolerance 
It should be noted that by default, the PowerMILL - 3D Area Clearance strategies will only 

detect perfectly flat surfaces. Surfaces that are not quite flat dimensionally will not be 

recognised unless the Flat Tolerance is set with a suitable value to allow for the deviation. 

This option is found in the Flats page of the Slice Area Clearance form. 

 

Note the Flat tolerance value entered 

will be added to the existing nominal Z 

height values. 
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Further information on Model Clearance Machining 
The following is reference information for the many different options contained in the Area 

Clearance form. This can also be found by using Help. 

Restrict Tool Overload – Trochoidal moves (PowerMILL Pro) 
This option is available to Area Clearance strategies in which Style - Offset model is set. 

The form for activating and inputting the Maximum overload value (%) is located on the 

High speed options page. 

 

 

 

 

 

 

 

 

 

If the tool reaches a specified overload situation 

PowerMILL automatically inputs a trochoidal path to 

eliminate full width cuts. This will occur in corners, 

narrow channels, slots, etc and the degree of movement 

is controlled with the slider as a percentage value in the 

form.  
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4. Finishing Strategies  

Introduction to Semi Finishing / Finishing Strategies 
 

Finishing strategies machine the actual component form and where applicable, follow on 

from the Area Clearance operation.  Suitable values are required to control the accuracy and 

amount of excess material to be left on a component by a toolpath. The parameters used for 

this purpose are called Thickness and Tolerance.  

 

Thickness is the amount of 

extra material specified to 

remain on the work-piece after 

machining. This can be applied 

generally (as shown), or 

independently as separate 

Radial and Axial values within 

the machining options.  

It is also possible to assign 

additional Thickness values to 

groups of Surfaces on the 

actual model. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

               Coarse Tolerance                Fine Tolerance 
 
Tolerance controls the accuracy to which the cutter path follows the shape of the work-piece. 

For roughing a Coarse tolerance can be used but for finishing a Fine tolerance must be used. 

 

Note where the Thickness value is greater than 0 it should always be greater than the 

tolerance value 
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Raster, Radial, Spiral, and Pattern Finishing. 

Introduction. 
This section will cover Finishing strategies created by the downward projection of a 

Pattern, which include four types, Raster, Radial, Spiral and (user defined) Pattern. 

 

PowerMILL generates the toolpaths by projecting a wireframe form down the Z-axis onto 

the model. The standard patterns applied in Raster, Radial, and Spiral are achieved by 

entering values directly into the Finishing Form. The resultant Pattern can be displayed by 

selecting Preview before executing the command by selecting Calculate. The Pattern option 

requires a user-defined geometric form (active Pattern), which is projected down Z onto the 

model as a toolpath. 

 

Typical previews of the four Pattern strategies are shown below as viewed down Z. 

 

Raster        Radial 
 

 

 

 

 

 

 

 

 

 

 

 

 

Spiral                 Pattern (User Defined) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The most frequently used Raster finishing strategy will be used as an example in the next 

section. 
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Raster Finishing 
 

• Delete All and Reset forms.  

• From File select Open Project and browse the form, to select the 
Project:-  C:\users\train\PowerMILL_Data\Projects\Chamber_Start. 

 
This time the example starts from an existing Project. 

 

• Select OK on the form that appears informing that the source Project is 
read-only. 

 

 

 

 

 

 

 

 

 

 

 

 

 

                  The model and tool stored in the imported Project are displayed. 

 

• From File select Save Project As:-                                   
       C:\users\training\COURSEWORK\PowerMILL-Projects\chamber 

 

• Calculate a Block to default Box - Model settings. 

• Select the Toolpath Strategies icon  from the top toolbar.  
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• From the Strategy Selector select the Raster Finishing icon then OK. 
 

• Name the 
toolpath 
Raster_basic. 

 

• Enter the 
Tolerance as 
0.02 and 
Thickness as 0. 

 

• Enter Ordering 
- Two Way. 

 

The default tolerance 

of 0.1 will give a fairly 

coarse surface finish. 

For a finer finish a 

lower value such as 

0.02 is used. A 

thickness of 0 will 

machine the material to 

size, within the 

tolerance. 

 

• Select a tool 
Stepover of 
1mm. 

 

• Calculate to process the toolpath and then Cancel the Form. 
 

On closer inspection the toolpath contains sharp corners in along the vertical plane, 

direction. 

 

 
 

 

Selecting the High speed page Arc fit corners option in the form will arcfit these to a 

maximum radius of 0.2 TDU. 
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• Right click over toolpath Raster_basic in the PowerMILL explorer and 
select Settings from the available menu. 

 

• Select the Copy Toolpath icon from the form.  

• Rename the new toolpath as Raster_arcfit. 

• From the local Raster Finishing, explorer, select the High speed options 
page. 

 
 
 
 
 
 
 
 

• Tick the box Arc Fit and edit the Arc Radius to the maximum value 0.2  
 

The value 0.2 (TDU), multiplied by the tool diameter (12mm) produces a radius of 2.4mm. 

 

• Press Calculate to process the toolpath and then Cancel. 

• Zoom into the same area to view the arc fitted toopath..  
 

 

 

 

 

 

 

 

 

    

At the end of each tool track the cutter retracts to the Safe Z height. This is a waste of time 

as these lifts are unnecessary. To make the toolpath a more efficient Link option can be 

applied. 
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• Select the Leads and Links icon  from the main toolbar.  

• Select the Links tab on the form. 
 

• Set the Short/Long 
Threshold to 2.0 

 
If the distance from the end 

of a tool track is within 

2mm from the start of the 

next, then the Short links 

option (Circular Arc) will 

apply. 

 

• Set the Short links to Circular Arc. 

• Set the Long and Default links to Skim. 

• Apply the Leads and Links and then Accept the form. 
 

 

 

All unnecessary retract moves have been eliminated with a 

circular arc move now forming the link between adjacent tool 

tracks. 

 

 

The next stage is to Simulate the latest, Active toolpath, Raster_arc fit. 

 

 
 
To Simulate the toolpath, 
right click over the toolpath 
icon in the explorer area, 
and select Simulate from 
Start. 
 

 

 

 

When the Simulate from Start is selected the toolbar will appear at the top of the screen, and 

the toolpath can be Simulated using the Play button. 

 

When the simulation has finished it will be observed that the tool remains at the end of the 

last retract move. To send the tool back to the Start Point either press the Home key on the 

keyboard or select the Go to beginning button on the Simulation toolbar.  
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To simulate the cutting moves locally and in more detail, it is possible to attach the tool to 

any position along the toolpath and use the Left/Right Arrow keys on the keyboard to make 

the tool move backwards or forwards along the toolpath. 

 

• Position the cursor at the required start point along the toolpath and right 
click to open the Toolpath pull down menu.  

 

Note; When the menu is accessed directly from the toolpath in the graphics area, the first 

option is Simulate from Nearest Point instead of Simulate from Start. 

 

• Select Simulate from Nearest Point. 
 

 

 

 

 

 

 

 

 

• Use the Left and Right arrow keys (bottom right corner of keyboard) to 
increment or move the tool forwards and backwards along the toolpath. 

Pattern Finishing 
This technique requires a user defined Pattern for projection onto the model as a toolpath. 

This option can be used for applications such as scribe lines, lettering, and non-standard tool 

strategies. A Pattern is created either from within PowerMILL or as imported Wireframe 

data. 

 

• Delete All and Reset forms.  

• Import the Model:  
                C:\users\training\PowerMILL_Data\Models\swheel.dgk 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The component is circular as a result of which the Block - Z Minimum and Z Maximum 

will be developed as a Circular billet.  
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• Select the Block icon from the main 
toolbar.  
 

• Select Defined by - Cylinder. 
 
The default Radius value represents the best 

cylindrical fit around the component achieved 

when the Calculate button is clicked 

 

• Select Calculate. 
 

• To provide more stock on the base 
Modify the Min Z value to –1, Lock 
the value, and Accept. 

 
 
 
 
 
 
 

• The Block can be displayed as wireframe or variable Opacity up to solid, 
depending on the position of the slider switch.  

 
 

 
 
 
 
 

 

 

 

 

 

 

 

Before the Pattern finishing strategy is created, a preliminary Area Clear strategy is 

required to remove the bulk of the material, leaving 0.5mm, followed by a Semi Finishing 

strategy leaving 0.2mm prior to the final Finishing. 

 

• Define a tool of Diameter 10 and Tip Radius 1, Named D10T1 with Tool 
Number 1. 

• Define a Diameter 6 Ball Nose tool Named BN6 with Tool Number 2. 

• Activate the D10T1 Tip Radius tool. 
 

• In the Rapid Move Heights         select Calculate. 
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• Calculate a Model Area Clearance toolpath using the following 
parameters:- Style - Offset all, Name - RoughOp1, Tolerance 0.1, 
Thickness 0.5, Stepover 5.0, Stepdown 1.0, and Cut Direction Climb. 

 

 

 

 

• Simulate the toolpath in Viewmill to 
give a result similar to as shown left. 

 

• Return the Viewmill display to No 
Image. 

 
 
 

• Activate the BN6 Ball Nose tool. 

• Calculate a Spiral Finishing toolpath using the following parameters:  
Name - SemiFinishOp1, Centre Point X 0 Y 0, Radius - Start 62.0, End 
0.0, Tolerance 0.1, Thickness 0.2, Stepover 1.0, and Direction -
Clockwise. 

 

• Simulate this new toolpath in ViewMILL. 
 

• Return the Viewmill display to No 
Image. 

 
 
 

• Right click over the SemiFinishOP1 toolpath in the explorer and select 
Settings. 

• In the Spiral Finishing form select the Copy icon.  

• Enter a new Name - FinishOP1, Use Tolerance 0.01, Thickness 0.0, 
Stepover 0.3 and then Calculate and Close the form. 

• Simulate the final toolpath in Viewmill to display the effects of the final 
toolpath. 

 
 
A Pattern finishing strategy will be now applied 

to machine the text, Engraved into the 

component. 

 

• Return the Viewmill display to No 
Image. 

 
 

 



4. Finish Machining Strategies                                                                                  PowerMILL 2011 

4.10 Issue PMILL 2011   

Next a pre-defined Pattern will be imported for use with the strategy. 

 

• Right click the Pattern icon in the explorer and select Toolbar….  
 

When Toolbar is selected off the Pattern menu it loads a new 

toolbar into PowerMILL. The toolbar contains icons to create an 

empty Pattern and insert different types of wireframe entities. 

The toolbar can be removed from the screen by clicking the small x 

on the right. 

 

 

 

 

 

 

 

• Select the Create pattern icon . 

• Click on the Insert - File into the Active Pattern icon . 
 

• Select the examples   
        shortcut button. 
 

• Double click the Patterns 
folder and then select 
Engrave.dgk. 

 

• Select Open. 
 
 
 
 
 
 
The Pattern is made up of 2D 

geometry and is positioned at the 

bottom of the Block. This will be 

projected along Z through the 3D 

model form to create a single 

toolpath with a negative 

Thickness value. 
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• Define a Ball Nose tool with Diameter 1 called BN1 and make this Tool 
Number 3. 

• Create a Pattern Finishing toolpath. 
 

• Enter the Name -
EngraveOp1. 

 
 

• Select Pattern 1 (if 
not already selected). 

 

• With Base position 
set to either 
Automatic or 
Vertical, the Pattern 
will project down Z 
onto the model. 

 

• Enter a Tolerance 
0.02 and Thickness 
-0.4 

 
 
 
 
 
 
 
 

 

• Select Calculate the toolpath then Cancel the form. 
 

 
By entering a negative Thickness 

the tool will machine into the 

previously finished surface. This is 

frequently used for engraving. 

Note: It is not possible to use a –ve 

thickness value that is greater than 

the Tool Tip Radius. There is 

however a way to achieve this if 

the user has a PowerMILL PRO 

license (Chapter 11 Patterns, page 

20 - Deep Pattern Machining). 
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• Simulate the path in Viewmill. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Save Project as:-                                            
            C:\users\training\COURSEWORK\PowerMILL-Projects\PatternMachining 

Pattern Exercise 
The same imported Pattern will be used to engrave text into a telephone handset. 

The Pattern, ‘Engrave’ used earlier will be out of position, but can be moved using the 

options on the Pattern - right click menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Right Click Models on the Explorer and Select Delete All. 

• Use File - Examples and load the model phone.dgk. 

• Deactivate Toolpath EngraveOp1. 

• Reset the Block, Rapid Move Heights and the Tool Start Point. 

• Generate a Pattern Finishing toolpath leaving all values as before. 
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3D Offset and Constant Z Finishing 
 

In this chapter 3D Offset and Constant Z finishing strategies will be applied to a model that 

consists of a combination of flat and steep areas plus a pocket with vertical walls. A 

Boundary will be created and used to limit the 3D Offset toolpath to the flatter areas leaving 

the remaining steep areas to be machined using the Constant Z strategy. 

3D Offset Finishing  
 

3D Offset Machining defines the tool Stepover relative to the 3D model surface providing 

consistency over both flat areas and steep sidewalls. In this exercise applying this toolpath to 

the complete model without using Boundaries would not be recommended. Although this 

toolpath maintains a constant Stepover there is nothing to prevent the tool plunging with a 

full width cut into the deep pocket area. 

 

• Delete All and Reset forms.  

• From File - Open Project and in the form browse to:-     
           C:\users\training\PowerMILL_Data\Projects\Camera_Start 

 
 
The Project is Locked and cannot be 

modified unless saved as a new file (or 

the original Project’s Lock file is 

deleted). 

 
 

 

• Select OK to load the existing Project into PowerMILL. 

• From File – Save Project As:- 
           C:\users\training\COURSEWORK\PowerMILL_Projects\Camera_Example 

 
 
 
 
 
The Project already 

contains an Offset Area 

Clearance strategy along 

with any associated 

Settings. 

 
 
 

 
This model is a good example where it is a better option to use more than one finishing 

strategy. 3D Offset (for shallow areas) and Constant Z (for Steep areas) will be used and 

they will be they will be kept separate using a Boundary. 
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• Activate the existing Model Area Clearance, Toolpath and Simulate the 
toolpath in Viewmill.  

 
 
The Viewmill simulation is 

as shown left. 

 

 

 

 

 

 

 

 

 

• Define a Ball Nose tool with Diameter 10 called BN10. 

Use of Shallow Boundary to define specific Machining Areas 
 

Specific Finishing strategies are more 

effective on either Steep or Shallow 

parts of the 3D component model. For 

example, Constant Z finishing is most 

effective on steep sidewalls while 

Raster Finishing is most effective on 

shallow areas. 

A Shallow Boundary will be created 

to discriminate the areas most suited to 

the individual machining strategies 

used. This type of Boundary is 

calculated taking into account the 

Active tool. 

 

 

There are several other types of Boundary options available to suit various applications and 

these are covered later in Chapter 6. 

 

• With the BN10 tool Active, right click on the Boundaries icon in the 
explorer and select Create Boundary -> Shallow. 

 
A Shallow Boundary defines segments from areas on the model that are defined by an 

Upper and Lower threshold angle. It is therefore specifically suited to steep walled and 

shallow surface machining techniques. 

 

With Radial Thickness set to 0.5 the stock thickness left on the sidewalls from the roughing 

will not be machined at this stage. 
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• Input the Name - 
ShallowBN10. 

 

• Input Upper Angle 
30 and Lower 
Angle.0 

 

• InputTolerance 0.02. 
 

• InputThickness 0 
 

• Ensure the correct 
tool BN10 is Active. 

 
 
 
 
 

• Apply and Accept the form. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With the model and toolpaths undrawn the Boundary should look something like this. It is 

made up of numerous segments each one dividing the model into steep and shallow areas. 

Any of which can be selected and individually deleted at any time except when Locked due 

being assigned to a toolpath. 
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• Select the Toolpath Strategies icon from the top of the screen.  

• Select a 3D Offset Finishing strategy from the form then OK. 
 

• Enter the 
Name  Bn10-
3DOffset 

 
 
 
 
 
 
 
 
 

• Select 
Direction to 
Climb. 

 

• Enter a 
Tolerance 
0.02. 

 

• Enter a 
Thickness 0. 

 

• Enter 
Stepover 1.0 

 

Notice that the newly created, Active Boundary is automatically selected for use. If a 

different Boundary is required it can be selected from the pull down menu. 

 

• In the local 3D offset finishing form explorer, select the Limit page. 
 

 

 

 

 

 

 

 
 
 
 

• Input the Boundary ShallowBN10 and Calculate to process the toolpath. 

• Cancel the form. 
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The toolpath follws the contours 

of the Boundary segments and 

is produced only on the shallow 

areas of the model (Inside the 

Boundary). 

 

 

 

 

 

• Select the Leads and Links icon from the top of the screen.   

• Select the Links tab and change the Short Links to On Surface, the Long 
and Default Links to Skim. 

• Apply and Accept the form. 
 
 
 
The toolpath has now is now 

more efficient with the rapid 

moves at skim height and the 

short links being forced onto 

the surface. 

 
 
 
 

• Simulate the 3D Offset toolpath in Viewmill. 

Constant Z machining 
Constant Z machining projects each tool track horizontally onto the component at fixed 

heights defined by the Stepdown.  

 

 

 

 

 

 

 

 

As the component surface becomes 

shallow the actual tool step over increases 

until it becomes non-existent on flat areas. 
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• Select the Toolpath Strategies icon from the main toolbar.  

• Select a Constant Z Finishing strategy from the form then OK. 
 
 

• Enter a Name as      
    ConstantZ_BN10. 
 
 

• Input Tolerance 
0.02 

 
. 

 

• Set the Direction to  
     Climb. 
 
 
 

• Input Stepdown 1 
 
 

 

 
 
 

 

 

 

 

• In the local Constant Z finishing form explorer, select the Limit page. 
 

 

 

 

 

• Set Trimming to   
     Keep outside. 
 

 

 

 

• Select Calculate to process the toolpath and then Cancel the form. 
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By using the Boundary Trimming option Keep Outside, the toolpath is correctly limited to 

the steep areas of the model. 

 

 

If the Boundary had not been used the 

toolpath would have looked like this. 

It can be seen that the parts of the toolpath on 

the shallow areas have an excessive 

Stepover. 

 

 

 

 

 

• Select the Leads and Links 
    icon at the top of the screen.  
 

• Select the Lead In tab and change the 1st Choice to Horizontal Arc Left, 
Angle 90.0 and Radius 2.0. 

 

• Click the button Copy to Lead Out. 
 

 
 
 
 

• Select the Links tab and change 
the Short, Long, and Default to 
Skim. 

 
 
 
 
 
 

• Apply and Accept the form. 
 

 

 

 

 

The tool now leads in and out of the toolpath with a horizontal arc. 

If the tool lifts it will only lift by the skim distance taken from the 

first page of the Leads and Links form (Z Heights tab).  

The Rapid moves at skim height are purple in colour while the 

plunge moves are light blue. 
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• Simulate the toolpath in Viewmill. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Save the Project (C:\users\training\COURSEWORK\PowerMILL-
Projects\camera) but do not Close. 

 

Other Constant Z Options 
 

Corner Correction to control whether changes of toolpath direction are High Speed - Arc 

fitted, Sharpened or unchanged (None). 

 

The Order By - Region (default) option will make Constant Z machine local features, such 

as pockets completely from top to bottom. The Order By - Level option will make Constant 

Z fully machine the model at each stepdown height. 

 

The Undercut option can be selected (if a spherical or disc cutter is used) to enable the 

machining of otherwise inaccessible areas. 

 

The Spiral option will make the Constant Z strategy produce continuous spiral tool tracks 

wherever possible (closed contours). 

 

The Machine down to flats option will ensure that the final pass at the base of a wall is 

exactly level with a flat area of the model (if applicable). 
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Post Processing and NC Programs. 
 

At this stage we will post process a single toolpath from the explorer as an  NC Program.  

 

 

All of the toolpaths that have been created in this chapter 

should appear in the explorer like this. 

This example will illustrate with the output of one single 

toolpath – Rough Op1 to be output as a post-processed 

ncdata file. 

 

 

 

 

 

 

• Right click over toolpath Rough Op1 in the explorer. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select the Create Individual NC 
Programs option. 

 

 

 

An NC Program is created called Rough Op1 and contains the 

toolpath. 

 

 

 

• Right click over the NC Program and select Settings. 
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The path to where the 

program will be output. 

 

Before post processing can 

occur the   required option 

file (*.opt) must be 

selected. 

 

• Select the folder 
icon to open up the 
Select Machine 
Option Filename 
form. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select the Heid400.opt and then Open. 

• Select Write at the bottom of the NC Program form. 

• Close down the subsequent form, which confirms the output using  
 

The contents of the output, NC Program can be viewed by double clicking on it in the 

Windows C:\ Temp\NCPrograms folder and view it in WordPad. 
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Corner Finishing. 

Introduction. 
Corner Finishing strategies are used to remove material in corners that are inaccessible to 

previously used, larger tools. There are 3 different types of strategy: Pencil, Stitch Corner, 

and Along Corner. The Pencil strategy creates 'single pass' machining along sharp internal 

corners while the other two perform local machining of the entire area of material 

inaccessible by a larger tool (Rest Milling). 

 

All Corner Finishing strategies allow a Threshold Angle to be specified. The Threshold 

Angle - determines the angle, from the horizontal, at which steep and shallow portions are 

split when you select a type of Steep or Shallow. This provides the user with the ability to 

prevent the tool running up or down steep slopes using editing techniques. For instance the 

user could easily apply a Stitch strategy to track across the steep areas while using the Along 

strategy in shallow areas.  

 

 

 

 

 

 

 

 

 

 

 

Corner Pencil Finishing 
This option produces single pass tool tracks along the intersection between sharp internal 

corners of the component surface.  

 

• From the File pull down menu select Delete All and from the Tools pull 
down menu select Reset forms. 

• From File - Open Project and in the form browse to:-
C:\users\training\PowerMILL_Data\Projects\CornerFinish_Start 

• Select OK to load the existing Project into PowerMILL. 
 
 
     The Project is Locked and cannot be 

modified unless saved as a new file (or the 

original Project’s Lock file is deleted). 

 

 

 

• From File – Save Project As:-   
      C:\users\training\COURSEWORK\PowerMILL-Projects\CornerFinish 
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• Select an Iso2 view.  
 

• Activate the toolpath D16T2-rghA1 to restore the settings. 

• From the PowerMILL explorer, Activate the Bn10 tool.  
 
 

• Open the Toolpath Strategies form        and from Finishing select 
Corner Pencil. 

• Input Name as Pencil_Shallow. 

• Select Output - Shallow and Tolerance 0.02 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Corner Pencil Finishing – explorer, select Tool and check that 
BN10 is selected as the active cutter. 

 
 
 
 
 
 
 

• Select Calculate to generate the Shallow slope machining only. 
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The toolpath is produced. The steep area is not machined. 

 

• Simulate the toolpath.  

• Right click over the toolpath in the explorer and select Settings. 

• Select the Copy toolpath icon from the form.  
 

• Change the Output option from Shallow to Steep. 

• Calculate the pencil machining toolpath (in the Steep areas only). 
 

 

 

 

Only the steep area is machined.  

 

 

 

 

 

 

 

 

• Simulate the toolpath. Rename the toolpath as Pencil_Steep. 

• In the main toolbar select File - Save Project. 
    
The contents of the Project will be updated:-     

         C:\users\training\COURSEWORK\PowerMILL-Projects\CornerFinish 

 
 
 
 
 
 



4. Finish Machining Strategies                                                                                  PowerMILL 2011 

4.26 Issue PMILL 2011   

Corner Along Finishing 
 

All the Corner Finishing 

strategies, (except for Pencil) are 

based on machining the area 

between the Reference tool (2) and 

the Active tool (1). 

 

In this example the main finishing 

tool is a 12 Ball nose (reference) to 

be Corner finished with a diameter 

5 Ball-nose. 

 

• Define a dia 5 ball nose tool named BN5. 

• Open the Toolpath strategies form  and from Finishing select 
Corner Finishing. 

• Input Name as CornerAlong_Shallow. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Change Output to Shallow and Strategy to Along. 

• Set Cusp to 0.03. 

• Set Cut direction to Climb. 
 
 
 
 
 
 
 
 

• Check that the BN5 tool is set (as above) on the Tool page. 
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• Select the Corner detection page and input the Reference tool as BN10. 

• Calculate to process the toolpath and then Cancel the form. 
 
Simulate the toolpath and observe 

the order of the machining . 

 
 

 

 

 

 

 

 

 

 

 

 

 

The Toolpath will be further improved by applying more suitable Leads and Links. 

 

• Open the Leads and Links form   and Set all the Links to Skim. 
 
 

• Select the Lead In tab.  
 

• Select Vertical Arc and fill in 
the values shown. 

 
 

• Click Copy to Lead Out. 
 
 
 
 
 

 
 

• Apply and Accept. 
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The Vertical Arc lead provides a 

smoother transition onto the work piece 

with the tool already moving at the 

specified cutting feed rate.  

 
 
 
 
 

Corner Stitch Finishing 
 

• From the Finishing strategies form, select Corner Finishing. 

• Input Name as CornerAlong_Steep. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Change Output to Steep and Strategy to Stitch. 

• Check that the BN5 tool is set on the Tool page. 

• Check that the Reference tool is BN10 on the Corner detection page. 

• Calculate to process the toolpath and then Cancel the form. 
 
 
 
This time only the steep areas have been machined. 

 
If required, it is possible to change the Direction and/or 

order of individual tool tracks via the Toolpath - Edit 

options. 
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• Right click on the toolpath and select Edit > Reorder. 
 
 
 
 
 
 
 
 
 

• Select Alternate directions. 
 

 
 
 
 
 

• In the Leads and Links form 
set Short Links to Circular 
Arc. 

 
 
 
 
 
 
 
 
 

 

• Apply the Leads and Links form. 
 
 
The steep areas now running two ways and this time the 

Short links are defined as a Circular Arc. 

 

 

 

 

 

 

• In the main toolbar select File - Save 
Project. 
    
The contents of the Project will be updated:- 

                          

                                              C:\users\training\COURSEWORK\Projects\CornerFinish 
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Exercise 

Create Finish Machining for an existing Rough Machined Project 
• Delete All and Reset forms.  

• From File – Open Project and in the form browse to:-
C:\users\training\PowerMILL_Data\Projects\ChainsawBodyDie_Start 

 
     The Project is Locked and cannot be modified unless saved as a new file (or the original 

Project’s Lock file is deleted). 

 

• Select OK to load the existing Project into PowerMILL. 

• From File - Save Project As:- 
    C:\users\training\COURSEWORK\PowerMILL_Projects\ChainSawDie-Ex 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Activate one of the existing toolpaths to reinstate the original settings. 

• Activate the existing Ball Nose tool - BN12  

• Create a Shallow Boundary with Thickness 0.  

• Create a Constant Z finishing strategy named BN12fin-CZ-OP1 limited to 
the steep areas of the model. 

• Create a 3D Offset finishing strategy named BN12fin-3DOff-OP1 limited 
to the shallow areas of the model. 

• Activate the existing Ball Nose tool - BN6 

• Create a Corner Finishing - Along strategy, named BN6fin-CnrAlong-
OP1, referenced to the larger BN12 tool. 

• Perform a full ViewMILL simulation. 

• Save the Project to update all the stored toolpaths. 
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Illustrations of typical Finishing Strategy solutions and corresponding ViewMILL solutions 

are as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                   BN12fin-CZ-OP1 

 

 

 

 

 

 

 

 

 

 

 

BN12fin-3DOff-OP1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

BN6fin-CnrAlong-OP1 
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BN12fin-CZ-OP1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BN12fin-3DOff-OP1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BN6fin-CnrAlong-OP1 
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PRO - Finishing Strategies 

Further Corner Finishing strategies 
 

In PowerMILL Pro two further Corner Finishing strategies are available. These include:- 

Corner MultiPencil (offsets tooltracks outwards from the Pencil intersection) and Corner 

Automatic (a combination of Stitch and Along). The option Output - Both also appears in 

all five of the Corner Finishing strategies. This creates separate groups of toolpath segments 

on both sides of the Threshold Angle. 

 

• Delete All and Reset forms. 

• From File - Open Project select the read-only Project:-      
C:\users\training\PowerMILL_Data\Projects\CornerFinishPro_Start 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select OK in the PowerMILL Warning form. 

• Save Project As:-   
    C:\users\training\COURSEWORK\PowerMILL-Projects\CornerFinishPro_Example 
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Corner MultiPencil Finishing 
 

• From the Toolpath strategies form, select Corner Multi-pencil Finishing 
 
 
 
 
 

• Change Output 
to Shallow. 

 
 

• Input the rest of 
the settings in 
3 the pages of 
the form exactly 
as shown. 

 
 
 

 
 

 
 
 
 
 
BN5 tool Active 

 
 

 
 

 
 
 
 
 
 
Reference tool BN10  

 
 

 
 

• Select Calculate but do not close the form. 
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MultiPencil appears to be very 

similar to the Corner Along 

strategy. There however 

fundamental differences one being 

the toolpath segments in Corner 

Along are offset from the outer 

profile inwards, whereas in 

MultiPencil the toolpath segments 

are offset outwards from the true 
intersection. 

 

 

• Select the Copy Toolpath icon from the form.  
 
 
 
 
 
 
 
 
 
 

• Change the Threshold Angle to 90. 
 
This has the effect of creating an unlimited Shallow machining area for the toolpath. No 

toolpath will be created if Output - Steep is selected with a Threshold Angle of 90. 

 

• Calculate the form to process the toolpath and then Cancel. 
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Corner Automatic Finishing 
 

• From the Toolpath strategies form, select Corner Finishing and input 
data into the form exactly as shown below. 

 
 

• Use Strategy 
-Automatic 

 

• Change 
Output to 
Both. 

 

• Change the 
Threshold 
angle back to 
30. 

 
 
 

 
 

• Calculate the form to process the toolpath and then Cancel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This strategy automatically uses Along for the Shallow areas and Stitch for the Steep areas.  
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Deep Cut Prevention 
 

In cases were the Reference Tool is too large to machine all the way down a deep pocket the 

excessive stock remaining could cause a smaller Corner Finishing Tool to overload and 

break. A tick box option is available in the Corner Finishing strategies (Except Corner 

Pencil) to Remove Deep Cuts. The user would then locally apply a more suitable strategy 

such as Constant Z Finishing into the deep areas. 

 

• Delete All and Reset forms. 

• From File - Open Project select the read-only Project :-      
C:\users\training\PowerMILL_Data\Projects\RemoveDeepCut-Start 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select OK in the PowerMILL Warning form. 

• Save Project As:-   
      C:\users\training\COURSEWORK\PowerMILL-Projects\RemoveDeepCut 
 

Note: The existing 3 strategies in the above Project are as yet, unprocessed (Calulator icon). 

 

• Right mouse click on each of the unprocessed Toolpaths, one at a time in 
the explorer and from the local menu select Queue. 

 
 
The 3 ‘Queued’ strategies will start processing in 

sequential order while the user continues to work in 

the PowerMILL Project. 
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• Activate the first Roughing strategy D12T1-RGH1 and from it’s local 
menu select Simulate from Start. 

• Open a Viewmill simulation session and simulate each toolpath in 
sequential order. 

 
 
The Pale Blue area shows where the Dia 10 

Ball Nosed tool has successfully machined.  

The deep pocket (Purple) is inaccessible and 

still includes large steps down the side wall. 

This excess stock could cause a smaller 

finishing tool to break if it attempts to Corner 

Finish down the pocket. To prevent this, the 

Remove Deep Cuts option will be used as 

demonstrated below. 

 

 

 

 

 

 

 

• Select the No Image icon  on the ViewMILL toolbar to display 
PowerMILL only in the graphics area. 

• Activate the BN4 tool. 

• From the Toolpath Strategies form, select Corner Finishing. 

• Input settings in the main page of the form as shown below:- 
 
 
 
 
• Output – 

Both 

 

• Strategy - 

Along 

 

• Threshold 
angle - 90 

 
 
 
 
 
 

• From the local explorer select the Corner detection page. 
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• Reference 
Tool - BN10 

 
 
 
 
 

• Untick  -
Remove deep 
cuts 

 
 

 

• Select Calculate to process the toolpath and then Cancel the form. 
 
 
 
 
 
 
 
 
The Corner Finishing has operated 

all the way down to the base of the 

deep pocket. 

Due to the excess stock this could 

cause the cutter to break. 

 

 

 

 

 

 

 

 

• Re-open (Settings) the above Corner Finishing - Along strategy and 

select Make a Copy.  
 

• Rename the new strategy as BN4-Fin1-NODeepCut and this time ensure 
that the Remove Deep Cuts box is ticked before selecting Calculate. 



4. Finish Machining Strategies                                                                                  PowerMILL 2011 

4.40 Issue PMILL 2011   

 

 

 

 

 

 

The Corner Finishing has not 

occurred in the deep pocket that is 

inaccessible to the BN10 reference 

tool  

 

 

 

 

 

 

 

 

• Save the Project. 

Exercise 
 

• Create a material Block defined by a Box, locally around the Pocket 
Surfaces (selected).  

• Using the same BN4 tool, create a Constant Z finishing strategy to step 
down the sidewalls.    
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Constant Z Finishing – Additional Stock option 
 

The Additional Stock option causes a Constant Z strategy to ignore the Pocket machining 

setting below the point where the width of a deep, angled slot reaches a specified width. 

Above this point the tool will continuously machine down each angled face in turn. Below 

this point the tool tracks will alternate in descending, height order from one face to the other. 

 

• Delete All and Reset forms. 

• From File - Open Project select the read-only Project:-      
C:\users\training\PowerMILL_Data\Projects\CZ_AddStock-Start 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select OK in the PowerMILL Warning form. 
 

• Save Project As:-   
    C:\users\training\COURSEWORK\PowerMILL-Projects\CZ_AddStock-EX1 

 

• Right mouse click on the Toolpath named Roughing and from the local 
menu select Activate to reinstate the original Block. 

• Right mouse click on the Toolpath named Roughing and from the local 
menu select Simulate from Start. 
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• From the top Pulldown menus select (tick) View - Toolbar - ViewMILL to 
open the ViewMILL toolbar (if not already open). 

 
 
 
 
 
 
 
 
 
 
 
 
 

• On the ViewMILL toolbar switch the Red sphere icon to Green to connect 
the simulation to ViewMILL. 

 
 
 
 
 

• Select the Rainbow Shading option in the ViewMILL toolbar and then 
select Play in the simulation toolbar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Roughing strategy has not fully machined a large volume of stock towards the base of 

the slot. This will have to be removed as part of a Constant Z finishing strategy. 
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• Right mouse click on the Toolpath named 0_AdditionalStock and from 
the local menu select Simulate from Start followed by Play in the 
simulation toolbar. 

 
 
 
 
The existing Constant Z finishing 

strategy is ploughing into the stock 

that was inaccessible to the 

previously simulated Roughing 

toolpath. The excessive loading is 

likely to result in tool breakage. 

To avoid this problem the 

Constant Z strategy will be 

modified to include the Add Stock 

option. 

 

 

 

 

• In the ViewMILL toolbar select the No Image (PowerMILL only) view. 

• Right mouse click on the Toolpath named 0_AdditionalStock and from 
the local menu select Activate followed by Settings to open the original 
Constant Z finishing form. 

 

• Select the ‘Create a new toolpath based on this one’ option. 
 

• Rename the new Toolpath as 8AdditionalStock and in the Additional 
Stock box input the value 8.0 before selecting Calculate. 

 
The choice of the 

selected Additional 

Stock value requires 

user intervention in 

estimating the width 

of the slot, just above 

the depth of material 

accessible to the 

Roughing strategy. 

 
 

• Repeat the ViewMILL simulation, starting with the Roughing strategy as 
before but then following with the new Constant Z strategy that has the 
Additional Stock value of 8.0 included. 
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The new Constant Z finishing strategy Pocket machines continuously down each side of the 

slot up to the depth where the width of the slot is equal to TDU + 8. The strategy then 

continues but with the Pocket option ignored for the remaining tool tracks, which alternate 

between each side wall in descending order. 
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3D Offset Finishing 
 

• Open the Project:- 
             C:\users\training\PowerMILL_Data\projects\CameraStart_Pro 

 
 
 
 
 
 
 
 
 
 
 

 
 

• Select OK to load the existing Project into PowerMILL. 

• From File – Save Project As:- 
           C:\users\training\COURSEWORK\PowerMILL_Projects\Camera_Pro 

 

• Right click over toolpath 3DOffset_BN10 in the explorer and select 
Settings from the pull down menu. 

 

• Select the Copy icon on the form.  
 

• Rename the toolpath as   
3DOffset_BN10_Spiral. 

 

• Tick the box Spiral. 
 

• Leave all other values 
the same then 
Calculate and Cancel 
the form. 

 

 

 

The Spiral option is essential for HSM 

(High Speed Machining) applications 

where ideally toolpaths should be as 

continuous as possible. 
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To further improve the compatibility of this strategy for HSM a Smoothing option can be 

ticked resulting in sharp corners being replaced with a smooth blend wherever possible. 

 

 

• Right click over toolpath 3DOffset_BN10_Spiral in the explorer and select 
Settings from the pull down menu. 

 

• Select the Copy icon on the form.  

• Rename the toolpath as 3DOffsetBN10_Spiral_Smoothing. 
 
 
 
 
 

• Tick the box 
Smoothing.  

 

 

• Leave all other 
values the same 

then Calculate and Cancel the form. 
 

 

 

 

 

 

 

 

 

 

 

 

 

        

                                                           Smoothing applied 

 

Note:- For optimum results the 3D Offset toolpath shape can also be controlled with a 

suitable Pattern used as the basis for the initial contour of each set of tooltracks. The user 

will need to be able to create a suitable Pattern which in this case consists of selected 

segments copied from the Boundary.  

Note: Patterns are covered in more detail in Chapter 11. 

 

• Right click over toolpath 3DOffset_BN10_Spiral_Smoothing in the 
explorer and select Settings from the pull down menu. 

 

• Select the Copy icon on the form.  

• Rename the toolpath as 3DOffsetBN10_Spiral_Smoothing_Pattern. 
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• Input the Pattern -
3DOffset_Template. 

 
 
 
 
 

 
 

• Leave all other values the same then Calculate to process the toolpath 
and then Cancel the form. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Pattern segments have now taken over 

from the Boundary to control the actual 

toolpath shape.  

The Boundary segments are now used solely to 

limit the areas covered by the toolpath. 

 

 

 

 

 

 

 

• Save but do not close the Project as it will be continued in the following 
section. 
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Optimised Constant Z Finishing  
 

This strategy is a mixture of Constant Z and 3D Offset machining. Where the model is 

steep, Constant Z is applied and for other areas, 3D Offset is applied. 

Closed Offsets if ticked will cause the 3D Offset areas of the machining to be ordered to 

occur from outside to inside. The reverse applies if Closed Offsets is unticked. 

 

• Deactivate the Shallow Boundary, ShallowBN10 in the explorer. 
 

• Open the Toolpath Strategies form          and from Finishing select 
Optimised Constant Z Finishing from the form then OK. 

 

• Enter 
    Toolpath name -     
     OptCZ-BN10. 
 

• Tick -Spiral, 
Closed Offsets, 
and Smoothing. 

 

• Enter the 
Tolerance as 
0.02. 

 

• Set the Direction 
to Climb. 

 

• Input a Stepover 
value of 1.  

 

 

 

 

 

• Make sure that 
the Boundary is 
not selected. 

 
 
 

 

• Leave all other values the same then Calculate to process the toolpath 
and then Cancel the form. 

 
 
Note the consistent Stepover between tool tracks across the whole component. 
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Optimized Constant Z generally performs well on Models that contain extreme Steep and 

Shallow areas, with a minimum of areas around 45 degrees to the vertical. A typical 

application would include many types of Thermoform Packaging. 

 

 

• Select the Leads and Links icon from the top of the screen to bring up the 
form and select the Links tab. 

 

• Change the Short/Long 
Threshold to 2. 

 

• Change the Short links to 
On Surface. 

 

• Change the Long and 
Default links to Skim. 

 

• Tick the Arc Fit Rapid 
Moves box with an Arc 
Radius value of 0.5  

 

• Apply and Accept the 
form. 
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Steep and Shallow Finishing  
 

This is an alternative strategy to Optimised Constant Z with different options which include 

a user defined Threshold Angle between the Constant Z, and 3D Offset areas of the 

toolpath as well the option to specify an Overlap value between them. 

 

• From the Finishing strategies form, select Steep and Shallow finishing. 

• Enter data exactly as shown in the following illustration. 
 

• Enter Name as:- 
      SteepAndShallow_BN10 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate to process the toolpath and then Cancel the form. 
 
 
 
 
The user is able to 

control the angular 

threshold between the 

3D Offset and 

Constant Z 
components of the 

hybrid Steep and 

Shallow finishing 
strategy. 
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Steep and Shallow Constant Z with separate Shallow Stepover 
 

Both Optimised Constant Z and Steep and Shallow have an option to apply a separate, 

larger Stepover across the Shallow areas. This is designed to provide more efficient 

machining with a Tip Radiused Tool, where the Shallow areas are perfectly flat. The Steep 

walls are machined using the tip radius with a fine Stepover and the flat areas using the 

base of the tool with a large stepover.  

 

• Delete All and Reset forms. 

• From File - Open Project select the read-only Project :-      
C:\users\training\PowerMILL_Data\Projects\ADV-Opt-ConstZ-Start 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Select OK to load the existing Project into PowerMILL. 

• From File – Save Project As:- 
      C:\users\training\COURSEWORK\PowerMILL_Projects\ADV-CZ-example 

 

• Right click over toolpath D16t3-OptConstZ in the explorer and select 
Settings from the pull down menu. 

 
The component form 

includes 2 Flat areas 

which are currently 

machined with the 

same small stepover as 

the angled walls. For 

more efficiency, an 

option is available for a 

larger stepover to be 

independently applied 

to the shallow (Flat) 

areas. 
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• Select the Copy icon on the form.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 
• Tick The Box named Use Separate Shallow Stepover and input a 

Shallow Stepover of 8.0  

• Select Calculate to process the toolpath and then Cancel the form. 
 

 
 

 

 

. 

 

 

 

 

 

 

 

 

 

 

• Open a new Steep and Shallow finishing form and input the same 
separate - Shallow stepover as used in the previous Optimised 
Constant Z strategy. 
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The Shallow options only 

become available in the 

local explorer if this box is 

ticked. 

 

 

 

 

 

 

 

 

 

 

• Input the Shallow 
options as shown 
left. 

• Calculate the 
toolpath before 
selecting Cancel. 
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Flat Finishing 
 

These strategies finish flat areas only, the definition of this being controlled by a Flat 

Tolerance value. Where applicable, they are usually run immediately after the main 3D Area 

Clearance operation. The Project imported for the next example already includes a 

preliminary 3D Area Clearance strategy. 

 

• Delete All and Reset forms. 

• From File - Open Project select the read-only Project:-      
C:\users\training\PowerMILL_Data\Projects\FlatFinish_Start 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select OK in the PowerMILL Warning form. 

• Save Project As:-   
      C:\users\training\COURSEWORK\PowerMILL-Projects\FlatFinish-Example 
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Offset Flat Finishing 
 

• In the explorer - Activate the Dia 16 End Mill (EM16). 

• From the Strategy Selector form, select Offset Flat Finishing. 

• Fill in the form exactly as shown on the following page and select 
Calculate. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Offset Flats 

finishing strategy 

will appear as 

shown left. In 

this case suitable 

Leads have been 

applied 

retrospectively:- 

Lead In/Out –  

1
st
 choice -- 

Pocket Centre   

2
nd

 Choice -- 

Horizontal Arc  
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The original imported Project contains both an Offset Area Clear roughing strategy and an 

Optimised Constant Z finishing strategy. It is recommended that Offset Flats (EM16Flats-

a1) is run directly after the 3D Area Clearance (D16t3-a1). For this reason, it would be a 

good idea to move it one place upwards in the explorer - toolpaths area. 

 

• In the explorer, move the cursor over the Offset Flats toolpath 
(EM16Flats-a1) and with the left mouse key depressed, drag it to the 
new position. 

 
 
 

 

 

 

 

• Perform a ViewMILL simulation on all 3 toolpaths to check that method 
and result of material removal is acceptable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Offset Flats strategy is shown above nearing the end of the ViewMILL simulation. 
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Raster Flat Finishing 
 

• From the Strategy Selector form, select Raster Flat Finishing. 

• Fill in the form exactly as shown below and select Calculate. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Raster Flat strategy   
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Flat Machining example 
 

• Delete All and Reset Forms  

• Import the model:-  
     C:\users\training\PowerMILL_Data\Models\Flats.dgk 

 

 

 

 

 

 

 

 

 

 

 

 

• Create a 20mm diameter End Mill tool named EM20. 

• Calculate the (default) Block and reset the Safe heights. 

• Open the Offset Flat Finishing form and fill in as below. 
 

• Name the 
toolpath EM20-
FlatFin. 

 
 
 
 

• Select the Use 
Axial Thickness 
icon. 

 

• Enter separate 
Thickness 
values for Radial 
0.5 and Axial 0. 

 
 
 
 
 
 
 
 
 
 

• Calculate the toolpath and Cancel the Offset Flat Finishing Form. 
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The Flat areas have been finish machined apart 

from between the ‘D’ shaped and oval Bosses as 

well as at the base of the holes due to the 20mm 

diameter tool being too large. We will now use a 

smaller tool to Rest machine these areas. 

 

 

 

 

 

 

• Create a 10mm diameter End Mill tool named EM10. 

• Active the toolpath Flat Fin EM20 and select Settings. 

• Select make a Copy          and fill in the form exactly as shown below. 
        

 
Toolpath Name:- 
EM10-
FlatFinRest 
 

 

 

Tick Rest 
machining (The 
Rest option will 
appear in the 
explorer). 
 
 
 
 
 
 
 
Stepover 3.0 
 
 
 
 
 
 
 

 
 

• From the local explorer select the Rest option. 
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• Input the 
reference 
Toolpath as 
EM20-FlatFin 

 
 
 

 

• Calculate the toolpath and Cancel the Offset Flat Finishing form. 
 
 

 

The bottoms of the holes and the area 

behind the boss have now been 

finished as shown left. 

 
 
 
 
 
 
 
 
 
 

Leads and Links - Arc Fit Rapid Moves 
 

PowerMILL Pro contains a couple of additional options in the Leads and Links form. 

These include On Surface link moves and the ability to Arc Fit rapid moves (provided the 

machine tool controller will support it). 

 

 

If the Short links are set to Skim and Arc Fit 

Rapid Moves is set, then arcs are added to the 

rapid moves. 

 

 

This option is ideal for applications where it is 

desirable to avoid sudden sharp changes in 

direction; for example (High Speed 

Machining). 
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Changing the Order and Direction within Toolpaths 
 

For toolpaths containing internal link moves, the order and direction of the tool tracks can 

be changed. For example, if a machining sequence starts at the bottom of part, progressing 

upwards, reversing the order will change the tool track sequence to start at the top of the part 

and progress downwards. In this case the direction in which the tool travels is unchanged. It 

is also possible to apply Reorder and/or Reverse to selected tool tracks within a toolpath. 

Typical reasons for applying Reorder and Reverse to toolpaths include minimising fresh air, 

tool movements, or to comply with the recommended tooling specifications (it is often a 

requirement in High Speed applications for the toolpath to both climb mill and track 

upwards).  

During applications where the base of a deep slot is to be climb milled, a uni-directional 

Raster Finishing Strategy will track across parallel, starting flush with one sidewall and 

tracking towards the other. By locally editing the order and direction a more desirable 

strategy can be created where tracking starts along the centre of the slot and progresses, climb 

milling, separately outwards towards both sidewalls. 

Changing the Order/Direction of tooltracks  
 

• Delete All and Reset forms. 

• Open the read-only Project:-      
      C:\users\training\PowerMILL_Data\Projects\EditToolpaths_3 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click OK in the PowerMILL Warning form and Save Project As:-       
      C:\users\training\COURSEWORK\PowerMILL-Projects\PunchForm_3 

 
The Project contains a Dia 10 Rad 1 Tipped Tool, and a 3D Offset finishing toolpath 

controlled by both Boundary and Pattern segments. 

 

• Simulate the toolpath using the Slow setting. 
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Observe the current direction and ordering of the strategy considering potential 

improvements. For example, the lower area machining would benefit from climb milling 

inwards towards the component form and the pocket machining could start central and climb 

mill outwards towards the sidewall. 

• Either right click over the toolpath and from the local menu select Edit -
Reorder or select Toolpaths - Toolbar to activate the following Toolbar. 

• Click on the Reorder Toolpath icon on the Toolpath Toolbar.  
 

 

 

 

Note the selected segments are shown highlighted in the form. 

 

 

 

 

Reverse order 

 

Reverse direction 

 

Alternate direction 
 

 

Each segment is listed in order of execution. If a toolpath segment is selected on the list the 

corresponding segment is highlighted in the graphics area (and vice versa). As a result it can 

be modified or moved to another position in the pecking order. 

The icons to the left hand side of the form are used for changing the order and direction of 

selected segments. If nothing is selected, the buttons when pressed will alter the whole 

toolpath. The 2 icons to the lower left of the form are Automatic Reorder  and 

Automatic Reorder and Reverse . These can only be applied to the whole toolpath and 
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not on selected tool tracks and are designed purely to minimise air moves (which in many 

cases could be produce a result which is detrimental to the order or direction of tool tracks).  

 

• Select all the tooltracks in the lower area and select Reverse Order. This 
part of the strategy should now climb mill inwards, towards the main 
component form (If not ‘climb milling’, then apply Reverse Direction). 

• Select the tooltracks in the central pocket and again select Reverse Order 
followed by Reverse Direction. This part of the strategy should now climb 
mill from the centre of the pocket outwards. 

 
Note:- Extra care is required when using the Spiral option in the selected finishing strategy 

as these are continuous tooltracks and can only be reversed and not internally reordered (If a 

spiral track is created to Upcut outwards then it can only be modified to Upcut inwards). 

 

 

 

 

 

 

 

Surface Finishing 
 

Surface Finishing creates a strategy that follows the surface curves on a selected Surface. 

Note:- The strategy will not run parallel to any trimmed, surface edges.  

 

• Activate the Dia 10,  Rad 1, Tiprad tool named D10t1. 

• Select the upper surface on the punch form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4. Finish Machining Strategies                                                                                  PowerMILL 2011 

4.64 Issue PMILL 2011   

• Open the Surface Finishing form and fill in as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• From the local explorer select the Pattern option. 
 

• Set Pattern direction - U 
 
 
 

• Select Two way. 

• Select:- 
     Min U max V  
 

• From the local explorer select the Limit option. 
 
 
 

• Make sure that no  
     Boundary is  
     Active (Empty box).             

      

• Select Calculate to process the toolpath and Close the form. 



PowerMILL 2011                                                                         4. Finish Machining Strategies 

                                                                  Issue PMILL 2011                                                                          4.65 

• From the Main toolbar, Select the Leads and Links option.  

• In the Links page input:-  
    Short/Long - Threshold 3     Short - Circular Arc       Long - Skim         
    Default - Incremental 
 
 
 
 
 
 
 
 
 

• Apply the above form. 
 

 
 
Where the Link move from 

the end of a tool track to the 

start of the next is within 

3mm, an (orange) arc move 

will be implemented. 

 
 
 
 
 
 
 
 

 

 

 

 

In the resultant toolpath the natural, order of the tool tracks and link moves across the 2 

narrow areas is not very efficient. 

This will be fixed by applying suitable toolpath Edit - Reorder options. 

 

 

• From the local toolpath menu (Right mouse click), select Edit – Reorder 
and in the form, click the Automatic reorder and reverse icon.  
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The Toolpath follows the curves of the selected Surface. 

The toolpath illustrated has been created with 1mm Stepover to help with visualisation. 

It has also been edited using the Automatic Reorder and Reverse option to eliminate as 

many air moves as possible. 

To further improve the efficiency of this strategy, several of the tool tracks on the upper flat 

area can be deleted to take advantage of using a bigger Stepover for the Dia 10mm flat area 

of the tool used. 

 

• From the main pull down menus, select Draw - Cursor - Tool to help with 
the visualisation for the next action. 

• Select groups of 6 tool tracks leaving the single tool track outside each 
set (as shown below left).  

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

        Tool outline displayed to visualise suitable Stepover (Draw - Cursor - Tool). 

 

• From the local toolpath menu (Right mouse click), select Edit - Delete 
Selected Components to remove the selected tool tracks. 
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Surface Finishing Exercise 
 

The direction of the curves on the selected surface will dictate whether the tool tracks are 

aligned along or across the model form. 

 

• Activate the D10t1 tip radiused tool. 

• Create a Surface Finishing strategy with the pocket sidewall surface 
selected using a 1mm Stepover (as shown below). 

 
 
Due to the natural direction 

based on along or across the 

surface, the tool tracks run up 

and down the sidewalls.  

This is not the correct choice 

as it is required to step the tool 

tracks down the sidewalls. 

 
 
 
 
 
 

 

• Recycle the above Surface Finishing strategy and change the Pattern 
Direction option from U to V and Calculate the form. 

 
 
 
The Toolpath now follows a 

direction, parallel to the base 

of the selected Surface.  

 

Note that the tool tracks do 

not run parallel to the trimmed 

top edge of the sidewall 

surface. 

 
 
 
 

 

 

 

 

Note:- A spiral option in the form of a tick box is available in the Pattern page of the 

Surface Finishing form. This can be applied for a continuous tool track down closed pocket 

or upstand areas.  
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Toolpath Processing Queue  
 

The Toolpath - Queue option allows the user to continue working in PowerMILL while the 

Toolpath is being processed in the background. (One or more Strategies can be added to the 

Queue and they are calculated in the background, in sequential order).  

The following ‘start up’ Project contains two unprocessed Toolpaths. The form for each one 

will be opened in turn, but Queue will be used instead of Calculate. This will enable the user 

to continue work on a new Corner Along strategy while the original toolpaths are 

processing in the background. 

 

• Delete All and Reset forms. 

• Open the read-only Project:-      
      C:\users\training\PowerMILL_Data\Projects\ToolpathProcessing-Start 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• From File select Save Project As:- 
      C:\users\training\COURSEWORK\PowerMILL-Projects\ToolQueue-ex1 

 

• In the PowerMILL explorer, right mouse click on the Toolpath named 
D25t3-rgh and select the option Queue from the local menu. 

• Repeat this on the Toolpath named BN16-fin1. 
 
 
 
 
 
 
 
 
 
 

 

• While the original Toolpaths are being processed in the background, 
Activate the Tool BN6. 
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• From the Finishing options. select the Corner Finishing using Strategy -
Along and enter the other values exactly as ‘shown below’. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the local explorer select the Corner detection page and input the 
Reference tool as BN16.  

 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate to process the toolpath and then Close the form. 
 
 
Note: The latest Corner Finishing strategy will start processing 

immediately and will more than likely, be completed before the 

Interleaved Finishing strategy currently pending in the Queue.  

 

 

 

When a Toolpath has been added to the Queue the unprocessed status, Calculator symbol in 

the explorer changes to the Queue symbol. 
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Bn6-fin1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• From File select Save Project to update the stored Project. 
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5.  Toolpath Leads and Links 

Introduction 
If a tool is allowed to start machining directly on the end of a tool track, it first ploughs 

though the remaining stock depth before suddenly changing direction to run along the tool 

track. This is likely to result in machining marks, vibration, and excess wear both on the tool 

and machinery. To avoid sudden loading on the tool, appropriate Lead moves (at cutting 

federate) on and off tool tracks can be applied. 

Fresh air (Link) moves between individual tool tracks can add a significant amount of extra 

time to a machining operation. This can be greatly reduced by applying alternative, Link 

move options.  

 

    

 

 

 

 < Default Leads and Links. 

 

 

 

 

 

 

 

  

 

The Leads and Links options            are selected either from the Main toolbar or from 

within the Finishing strategies forms. They can be applied retrospectively to an existing 

toolpath. 
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Z Heights 
 

Skim and Plunge distance provide variable control of rapid move heights within a 

component. These operate in conjunction with Safe Z and Start Z to minimise slow and 

unnecessary movement of the tool in fresh air while machining the component form. 

 

Skim distance – An incremental distance above the model at which rapid moves occur from 

the end of one tool track to the start of the next. The tool traverses at a high feed rate (G1) 

across the model clearing the highest point along its route by the Skim value. 

 

Plunge distance – An incremental distance above the local component surface where a 

downward rapid movement of a tool changes to plunge rate.  

Lead In/Lead out Moves 
Lead In controls the tool movement onto the start of a tool track and Lead Out the 

movement away from the end of a tool track. Lead In moves available include None, 

Vertical Arc, Horizontal Arc, Horizontal Arc Left, Horizontal Arc Right, Extended 

Move, Boxed and Ramp. The same options exist for Lead Out moves apart from the 

omission of Ramp. 

 

 

Illustration shows:- 

Lead In/Out - Vertical Arc and   

Incremental - Skim - Link moves. 

 

Toolpath colour codes:- 

Purple - Rapid Skim Feed Rate G1 

Pale Blue - Plunging Feed Rate G1 

Green/Orange - Cutting Feed Rate G1 

Dotted Red - Full Rapid G0 

 

 

 

 

Leads and Links are effectively extensions to tool tracks and as result must be gouge 

protected. To prevent gouging, the Gouge Check flag should be ticked (default) on the 

Toolpath Leads and Links Form. Any Lead that would result in a gouge will not be 

created. The following examples illustrate different leads and links, and unless otherwise 

stated, Gouge Check should always be set. 

If any instances occur where the 1st Choice cannot be applied then the software will apply 

the 2nd Choice. If neither option is valid under gouge check conditions then the Lead will be 

locally applied as None. 

The Current settings of Leads and Links are included in the creation of new machining 

strategies. Alternatively they can be applied later to the Active toolpath in the explorer. 
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Example 
• Delete All and Reset forms.  
• From File select Open Project and select the readonly Project:-        

         C:\users\train\PowerMILL_Data\Projects\LeadsLinks-Start 

 
 
A message informing the user that the 

Project is ReadOnly will appear. 

 
To continue, a copy of the Project will 

be created to allow the user to make 

changes (Save As). 

 
 
 
 
 

• From File select Save Project As:-         
       C:\users\training\COURSEWORK\PowerMILL-Projects\LeadsLinks-example 

 
 
The Project contains 1 Roughing toolpath and 3 Finishing 

toolpaths. The following example will illustrate the 

retrospective addition of suitable Leads and Links to the 3 

finishing toolpaths.  

 

 

 

• Select an ISO2 view. 

• Right click on the Toolpath BN6-fin1 and select Activate. 
 

• Open the Leads and Links form. 

Vertical Arc Leads 
 

Vertical Arc Leads create a circular movement downward at the start and upward at the end 

of each individual tool track. By default, the additional moves will not occur in instances 

where a Gouge would be caused (Gouge Check box ticked). 

 

 

 

 

 

 

 

 

 

 

 

Toolpath 

Segment 

Tangent 

Angle 

Radius 

Lead 
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• Select the Lead In tab and for 1st Choice input an Angle 90.0 and Radius 
6.0 before clicking Apply at the bottom of the form. 

 
 
 

There is now a Vertical Arc leading onto 

most of the tool tracks. If the required 

Lead Out is to be exactly the same as the 

Lead In and vice versa the Copy to Lead 

Out option allows easy copying of the 

settings between the two.   

The Leads in this area have remained 

unchanged as any Vertical Lead In/Out 

using the current Radius value would 

gouge the model if allowed to appear. 

 

• Select the Copy to Lead Out button. 
 

 

 

 

 

 

 

 

• Apply the form to update the Active toolpath. 
 

 

Where the operation is gouge free a 

Lead Out move, similar to the Lead 

In is applied at the end of each tool 

track. 

 

The Leads in this area have 

remained unchanged as any Vertical 

Lead In/Out using the current 

Radius value would gouge the 

model if allowed to appear. 
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• Select the Lead In tab and for 2nd Choice input Vertical Arc with an 
Angle 90.0 and a reduced value Radius 4.0.  

• As before, select the Copy to Lead Out button before clicking Apply at the 
bottom of the form. 

 
Wherever it is gouge free the 1st 

Choice of a Radius 6, Vertical 

Arc, Lead In/Out is applied.  

 

If this is not possible without a 

gouge occurring, then the 2nd 

Choice of a Radius 4, Vertical 

Arc is attempted. 

 

If neither the 1st or 2nd Choice is 

possible without a gouge 

occurring, then no Lead In/Out 

will be applied to that part of the 

toolpath. 

 

 

Horizontal Arc Leads 
This produces circular leads on the horizontal plane, and the Radius and Angle value is 

similar to that for Vertical Arc. This type of lead is frequently used for toolpaths running at 

constant Z, or with only small changes in Z height. 

 

Toolpath

Segment

Tangent

Angle

Radius

Lead

 



5. Leads and Links                                                                     PowerMILL 2011 

 

5.6 Issue PMILL 2011    
 

• Right click on the Toolpath BN6-fin2 and select Activate. 

• Select an ISO1 view. 

• Open the Leads and Links form. 

• In the top Pull down menus select Tools - Reset Forms to return the 
Leads and Links settings to default. 

 
 
 
 
 
 
 
 
 
 

• Change the 1st Choice Lead In to be a Horizontal Arc with Angle 45 and 
Radius 3.0 then select the Copy to Lead Out button before selecting 
Apply. 

 

There is no need to input a 2nd 

choice as the Horizontal Arc - 

Leads In/Out have appeared on all 

the tool tracks. With Horizontal Arc 

set, PowerMILL decides whether to 

use Left or Right hand arcs. They are 

also calculated to comply with the 

Gouge Check flag. If it is not 

possible to apply the specified lead 

due to a gouge situation it will remain 

as the default vertical move unless 

the Gouge Check flag is unchecked 

(not recommended). 

 

 

• In the 1st Choice - Lead In input Distance 5 and Apply the form. 
 
 
 
 
 
 
An additional (Distance) extension 

move is added to the tool track before 

the original Lead In option ‘kicks in’. 
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Extensions 
Extensions provide the option for the user to add an additional lead move option onto the 

existing Lead In/Out. As an example, a Vertical Arc - Extension will be added to the Lead 

In/Out moves. 

 

• Select an ISO2 view. 

• In the Leads and Links form, select the Extensions tab and for both the 
Inward and Outward options, input a Vertical Arc with an Angle 90.0 and 
Radius 5.0.  

 

           

 

 

 

 

 

• Apply the form. 
 
 
A Vertical Arc Extension has successfully been 

added to all of the Lead In/Out moves. 

 
 
 
 

 

Links 
A Link is the movement from the end of a tool track to the start of the next. To provide for 

more efficient movement of the tool across the component the height of the link moves that 

connect adjacent tool tracks can be reduced to be closer to the local model form.  

 

Short/Long Threshold - This defines the distance limit up to which the Short - Links apply. 

Any move from the end of a tool track to the start of the next, which exceeds this distance is 

defined as a Long - Link move. 

 

For Short links the available options include Safe Z, Incremental, Skim, On Surface, 

Stepdown, Straight, and Circular Arc. 

 

For Long links the available options include Safe Z, Incremental, and Skim. 

 

Safe links apply only at the start and end of a toolpath the available options being Safe Z, 

Incremental, and Skim. 

 

For users with a PowerMILL PRO licence:- 

Where a machine control system will permit arc fitting of rapid moves the Arc Fit Rapid 

Moves box can be ticked along with a suitable Radius based on the active tool diameter 

TDU (Of particular benefit to High Speed Machining). 
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• Activate the toolpath bn6-fin1 created earlier in the Leads section. 
 

• Open the Leads and Links form. 

• In the top Pull down menus select Tools - Reset Forms to return the 
Leads and Links settings to default. 

• Select an ISO 2 view. 

• Select the Z Heights tab to access the Skim and Plunge Distance boxes. 
 

The values will be left as default 

for the time being. 

 

The Skim Distance is the 

Incremental height at which the 

tool clears the model form 

between tool tracks. 

 

The Plunge Distance is the 

Incremental height at which the 

tool rapids down to before using 

the Plunging Feed Rate. 

 

 

• Select the Links tab to access the Link move options. 
 

 

 

 

 

 

 

 

 

 

• Input the Short/Long Threshold as 3 (Link move distances less than this 
value will use the Short link option and those greater will use the Long 
link option). 

• Select Short as Circular ad Long and Default as Skim. 

• Apply the form. 
 

 

Note that the distance between 

the ends of adjacent tool tracks is 

greater than the Short/Long 

Threshold value in several areas 

of the toolpath (Skim Link 

moves apply). 
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• Change the Short/Long Threshold to 5 and Apply the form again. 
 

Note that by increasing the value of the 

Short/Long Threshold the number of 

Short Link Cicular Arcs has greatly 

increased. 

The remaining lift and plunge moves 

would benefit from Vertical Arc Lead 

In/Out moves but not the existing 

Circular Arc Links. This can be achieved 

locally by selecting the individual lift or 

plunge moves and then applying the Leads 

and Links form.  

 

• Apply a Vertical Arc to both Lead In and Lead Out as shown below 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Vertical Arc - Leads 

are currently adding to the 

Circular Arc - Short link 

moves.  

 

This can be suppressed by 

unticking the box labelled   

Add leads to short links. 
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• Untick the box labelled Add leads 
to short links. 

 

• Apply the form. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

As shown above the Vertical Arc - lead moves no longer exist on the Short links (Circular 

Arcs). 

Applying Leads and Links locally to individual tool tracks 
 

• With the Shift key depressed, select one of the individual link moves 
where the Lead is currently a Vertical Arc. 

• In the Leads and Links form select the Lead In tab and select 1st Choice 
as Extended Move with Distance 10. 

• Select the Copy to Lead Out tab and then Apply the form. 
 
                                                                    Selected Link Move  

 
 
 
 
 
 
 
 
 
 

The selected Vertical Arc lead move is individually edited to become an Extended move 

As shown above. 

 

• From File select Save Project to update the stored Project. 
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Additional Short Links options 
 

In addition to Safe, Incremental, and Skim the following additional options are available in 

the Short Links section. These additions are not available in the Long Links options. 

 

On Surface 
This links the tool tracks with a gouge free, direct move that follows the surface form. 

 

Stepdown 
The link move remains at a constant height and performs a gouge checked, move over to the 

start of the next tool track where it then feeds down onto the surface. 

 

Straight 
In this case the link is a gouge checked, direct linear move to the start of the next tool track. 

 

Circular Arc 
This links the tool tracks with a gouge free, circular move that follows the surface form. 

Exercise 
 

• Activate the toolpath BN6-fin3 and Apply the Leads and Links as 
follows:- 

 
Links:-   

Long/Short/Default - Skim 
 

Lead In:- 

1st Choice - Ramp (Options - Max Zig Angle 4 and Ramp Height 1)  

 

Lead Out:- 

1st Choice - Vertical Arc - Angle 90 - Radius 3 and Overlap Distance 0.2  

 
 
 
Overlap Distance continues the cutter 

before or after the natural end point 

(Along the original toolpath) by a 

specified distance based on the Tool 

Diameter (TDU). 

 
 
 
 
 
The finished Leads and Links will be as 

shown above. 
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 Pro – Arc Fitting Rapid Moves 

Leads and Links 
 

 

Note that arcs can be applied to the 

Rapid Moves (If the individual 

Machine tool controller supports the 

option). 

 

The Arc Fitting works on all Rapid 

Moves including Skim moves. 

This option is ideal for applications 

where it is desirable to avoid sharp 

changes in direction; for example (High 

Speed Machining). 

 

 

 

 

The Arc Fit Rapid Moves option is located in the Links form.  

To activate the option the Arc Fit Rapid Moves box must display a tick. 

The radius of the Arcs is also controllable as a proportion of the active Tool Diameter 

(TDU). 
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6. Boundaries 

Introduction. 
A Boundary consists of one or more closed (wireframe) segments, the main application 

being to limit machining strategies to specific areas of the component. Earlier in the course 

Boundaries have been utilised to limit machining strategies so that they occur in more 

compatible areas of the component. For example Constant Z finishing is more effective on 

Steep sidewalls and Raster finishing on Shallow areas. 

There are several standard options available for Boundary creation. 

 

 

 

 

 

 

 

 

 

User defined Boundary 
This type of Boundary is created from the options contained in an additional sub-menu. 

While all other main Boundary options involve interaction with other PowerMILL entities 

the User Defined options generally involve direct conversion of existing wireframes. 

 

 

 

 

Boundary, Pattern, and Toolpath 

icons are greyed out unless a 

suitable entity is selected. 

 

Model:- Inserts the edge of the 

selected model. 

Sketch:- Enables free form 

coordinate input. 

Curve Modelling:- Opens a 

Composite Curve generator. 

Wireframe Modelling: Provides 

access to the wireframe part of 

PowerSHAPE.   

 

 

• From the main pulldown menus select File - Delete All. 

• From File Import the model:- 
                  C:\users\training\PowerMILL_Data\Models\cowling 
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• Select the surfaces defining the central pocket and fillet. 
 
 
 
 
 
 
 
 
 
 

• In the explorer right click over Boundaries and select Create - User 
Defined and in the User Defined Boundary form left click the Model icon 
(arrowed above). 

 
 
 
 
A Boundary segment is created 

around the edge of the selected part 

of the model. 

 

 

 

 

 

 

 

 

 

• Select a View from top (Z) and switch off the Shading retaining the 
Wireframe view. 
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• In the explorer right click over Boundaries - Create Boundary - User 
Defined and in the User Defined Boundary form left click the Sketch 

icon.  
 
The Curve Editor toolbar (shown below) will appear above the Graphics area. 

 
 

• In the Curve Editor toolbar select the Curve editor options icon. 
 
 
 
 
 
 
 
 
 
 

• Select Intelligent Cursor - Snapping Options and untick the Use of 
Intelligent Cursor box to enable full ‘free form’ sketching to occur. 

• Accept the form. 

• In the Curve Editor toolbar, select the create Continuous Lines option.  

• Using the left mouse key, snap points to create a sketched Boundary.  
 
 
 
Note: Do not attempt to close the 

segment by trying to snap the ‘final 

span’ back on to the start point. Use 

the Close segment icon to achieve an 

exact match. 

 
 
 

 

• For any invalid points, sequentially remove using the Undo icon          and 
to insert the final span select the Close segment icon. 

 
Points can also be input as Incremental values, using X Y Z coordinates in the data input 

box, located below the graphics area. 

 

 

 

 

To insert as absolute coordinate values toggle the icon from            to           . 
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• Once the segment is closed, exit the Continuous line mode toolbar by 
selecting the small cross  at the far right. 

 
 

• In the Curve Editor toolbar, select the Accept changes icon         to 
accept and close the Sketch Boundary session. 

• With the segment selected, right click on the new Boundary and in the 
local menu click on Edit - Spline Selected to open the following form. 

 
 
 
 
 

• Enter a value of 2 before selecting the green tick to apply and close. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Boundary segment is splined through the polyline points where doing so maintains the 

original form to within a maximum deviation of 0.5. In instances where this is not possible a 

tangency will remain either side of the point. 
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Selected Surface Boundary 
 

A Selected Surface Boundary defines one or more segments where the active tool looses 

contact with the selected surfaces. The segments represent the tip of the active tool. 

 

• Create a Block Defined by Box using Type Model. 

• Create a Ball Nosed tool of Diameter 16 with the Name bn16. 

• Select the surfaces defining the central pocket including the fillet. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the explorer right click over Boundaries and select the option Create 
Boundary - Selected Surface. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Using the above settings Apply the form to create the above Boundary 
segment. 



6. Boundaries                                                                    PowerMILL 2011 

6.6 Issue PMILL 2011   

Shallow Boundary 
This type of Boundary defines one or more segments where the model drops through a 

specified Threshold Angle downwards from the horizontal plane. It is designed to 

differentiate steep and shallow areas where Constant Z and Pattern strategies are 

respectively, more effective.  The Boundary is calculated relative to the Active tooling 

parameters.   

• In the explorer right click over Boundaries and select the option Create 
Boundary - Shallow. 

 
Typical area more suited to a 

Pattern strategy (above 35 

degrees). 

 

 
 
 
 
 
 
 
 
 
 
 

Typical area more suited to a Constant Z strategy (below 35 degrees). 

 

• Using the above settings Apply the form to create the above Boundary 
segments. 

Silhouette Boundary 
This type of Boundary defines the 2D the outline around the selected model adjusted to the 

contact point of the tool along Z. 

 

• Select the following surfaces on the model (use the Shift key to enable 
multiple Selection). 
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• Right click over the model in the graphics area and in the local menu 
select Edit - Delete Selected Components. 

• With the shutout areas now deleted, right click over Boundaries in the 
explorer and select the option Create Boundary - Silhouette. 

 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

Rest Boundary 
This type of Boundary defines the area inaccessible to a specified Reference tool. It also 

requires an (smaller) active tool to be specified otherwise it will not generate segments. 

 

• Create a Ball Nosed tool of Diameter 8 with the Name BN8. 

• In the explorer right mouse click over Models and select Delete All to 
remove the now (incomplete) component. 

• Import the original (complete) Model back into the Project:-     
          (C:\users\training\PowerMILL_Data\Models\cowling)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• In the explorer right click on Boundaries. 
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• Select Create Boundary and select Rest to open the Rest Boundary 
form. 

 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

• Modify the values in Expand Area to 0, enter bn8 as the Tool, and bn16 
as the Reference Tool and click Apply to create the following Rest 
Boundary. 

• Accept the form. 

• Select a View down the Z Axis           and Undraw the model.  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
The above Boundary identifies areas on the component that are inaccessible to the bn16 tool 

geometry to be locally machined with the bn8 tool. On closer inspection the central pocket 

area would be more effectively machined with a flat bottomed tool and a smoother more 

continuous toolpath will be achieved if the 2 spurs were removed from the outer segment, to 

be machined later as a separate toolpath. 
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Block Boundary 
This Boundary option creates segments as a profile around the Block definition. 

 

• In Rapid Move Heights - Reset to safe heights. 

• Use the default Start and End Point settings. 

• Calculate a Block, Defined by Box with Type Model. 

• In the explorer right click over Boundaries and select the option Create 
Boundary - Block. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The resultant 2D Boundary is defined around the outside edge of the Block at Z0. 
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Editing Boundaries 
Several options are available that enable the user to modify the geometry of a Boundary. 

These include Curve Modelling, Curve Editor, and Wireframe Modelling (Chapter 12). 

 

• In the explorer right click the Rest Boundary (6) icon to open the local 
pull down menu and select Edit - Copy Boundary to create a copy named 
(6_1). 

• In the explorer right click over the original Rest Boundary (6) and 
Rename as Master. 

• Rename the new copy of the Rest Boundary (6_1) as Rest. 

• In the explorer click (off) the light bulb adjacent to the copy (Master) to 
remove it from view in the graphics area. 

• Delete the 2 inner segments on Boundary (Rest) by boxing over them 
with the left mouse (select) and press the Delete key on the keyboard. 

 
 
 
 
 
 
 
 
 
 
 
The next stage is to remove the two spurs (arrowed) which will be carried out after an 

explanation of the Boundary Editor Form. 

Boundary - Curve Editor 
Once created, a Boundary segment can be modified using a series options accessed from the 

Boundary Toolbar.  

 
 

 

The Curve Editor toolbar can be made Active by selecting the option          from the above 

Boundary toolbar (Alternatively, if a Boundary segment is double left mouse clicked the 

Curve Editor toolbar will become active). 

Curve Point - editing 
 

The Point editing options                                can only be applied to Continuous Line 

(Polygonised) segments. 
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• From the PowerMILL explorer - Right Mouse Click on Boundary and 
from the local menu, select Toolbar. 

• From the Toolbar select the Curve Editor option to open the Curve 
Editor toolbar. 

• Select the outer - Boundary segment in the graphics area. 
 
 
The Points will be displayed on 

the selected Boundary 

segment. 

 
 
 
 
 
 
 

• Zoom into the area of the selected segment (shown below) and select all 
the Points that define the spur (Hold down the Shift key while selecting 
with the left mouse key).  

 
 

 

 

 

 

 

 

 

 

 

 

• From the Curve Editor toolbar select the Delete points option           to 
remove the spur from the segment. 

• Repeat the procedure on the other spur (as shown below). 
 

 
 
 
 
 

 

                                        

 Note:- The point removal process on 

this side has caused the segment to be 

opened. This will be fixed using the 

Join close option. 

 



6. Boundaries                                                                    PowerMILL 2011 

6.12 Issue PMILL 2011   

• From the Curve Editor toolbar, select the Join close option 
to re-create a closed segment. 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

• Make sure that neither of the 2 seqments is selected (Unselected 
segments will not be returned from the Curve Editor). 

• To accept the changes and exit the Curve Editor, select the Green Tick 

option.  
 

Other editing options (as shown below) are accessed by right clicking over a Boundary 

either in the graphics area or in the explorer and then selecting Edit from the local menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select the outer segment of the Boundary (Rest) and Right Click on it in 
the explorer to open the local pull down menu. 
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• Select Edit - Spline Selected entering a Spline fitting tolerance value of 
0.1 in the form before clicking the Green Tick to apply. 

• Re-select the outer segment to visualise the effect of the Spline (as shown 
above right). 

 
The Selected Segment has now been Splined (Curve fitted and the points re-distributed 

within the specified tolerance value) to produce a smoother form with any unnecessary 

points removed. This will improve the quality of subsequent operations such as offsetting of 

the Boundary. 

Note: It will not be possible to access the Curve editor - Points options on the ‘Splined’ 

segment unless it is converted back to Continuous line style (Polygonise). 

 

• Right click on the Boundary icon named Rest in the explorer to open the 
local menu again. 

• Select Edit - Transform - Offset to open the Curve Editor - Offset form. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• In the Offset form select the 3D Smooth option and input a Distance of 1 
before applying the return key. 

• To accept the changes and exit, from the Curve Editor toolbar, select the 

Green Tick option.  
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• In the explorer click (on) the light bulb adjacent to the copy of the original 
Boundary (Master) created earlier (It will be displayed alongside the 
edited Boundary (Rest) as shown above illustrating the effect of the 1mm 
3D Offset). 

• Select the Toolpath strategies icon           to open the following form and 
select the Finishing options. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Make sure that the BN8 tool and Boundary named Rest are both Active. 

• Select 3D Offset Finishing to open the following form and enter data 
exactly as shown below. 
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• Calculate the form to process the toolpath before selecting Cancel to exit 
the form.   

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Undraw the Toolpath (BN8_RestFin) and Boundary (Rest) by switching 
off the respective light bulb symbols in the explorer. 

• Select the outer segment of the displayed Boundary (master). 
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• Right click the Boundary icon (Master) in the explorer to open the local 
pull down menu and select Edit - Copy Boundary (selected only) to 
create a new Boundary (master_1) consisting of the outer segment only. 

• Open the local pull down menu again and Rename the copy as (Spur1). 

• In the explorer click (off) the light bulb adjacent to the Boundary (master) 
to remove it from view. 

 

• Right click over the Boundary icon (Spur1) in the Explorer and select 
Activate. 

• Double left click on the Boundary segment to activate the Curve Editor 
toolbar. 

• With the Shift key depressed, Select all points along the Boundary 
segment except those defining the rectangular part off the upper spur.  

 
 
Notes:-  
1/   The point selection 

process can be carried out in 

stages enabling the user to 

Zoom in as the bulk of the 

points have are deleted. 

2/   If it is required to 

deselect one or more of the 

selected points the CTRL 

key is used during the 

selection process. 

 
 

 
 

• In the Curve Editor toolbar select the Delete Points option.  
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                                                                             -2 

                                                                                       
• Select the Join Close option to close the open segment. 

• Shift - Select the points at the base of the rectangular segment. 
 
 
 

• From below the Graphics Area with Relative move    selected, input 
0 -2 in the Data input box and return (The selected points will move by a 
distance of Y-2). 

• Select the Green Tick  to exit the Curve Editor toolbar. 

• Display (light bulb on) both Boundaries - Rest and Spur_1 
 

• Resize the View. 
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• In the explorer right click the Boundary (Spur_1) and from the local 
menu select Edit - Transform - Mirror. 

• In the Transform Boundary form select the mirror ZX option (Note: The 
default, keep original is set). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click on the small cross to accept the mirror operation and close the 
form. 

• Select the Green Tick         to accept and exit the Curve Editor toolbar. 
 
The 2 separate spur segments are now both contained in the Boundary named Spur_1  

 

• Make sure that the tool - BN8 and Boundary - Spur_1 are both Active. 

• Open the Strategy Selector form and select the Finishing options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select the Raster Finishing option. 
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• In the Raster Finishing form and enter data exactly as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate to process the toolpath and then select Cancel to exit 
the form. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The machining strategies have been localised and the tooltrack shape controlled with the help 

of edited Boundaries originating from a single Rest Boundary. 
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• Save the Project As:-  
            C:\users\training\COURSEWORK\PowerMILL-Projects\Boundary-tests 

 

 

 

 

 

 

 

 

 

 

Creating Blanking Surfaces using Boundaries 
 

Blanking Surfaces are used to cap holes and pockets in a model to prevent the tool from 

machining into those areas. There are three types of Plane that can be created in 

PowerMILL. 

1. Block – allows the creation of a plane at a specific Z Height after the material Block 

had been defined. 

2. Best Fit – creates two planes, one touching the boundary at its highest point and the 

other through its lowest point. The planes are parallel to the best fit plane (the plane 

that has the smallest maximum distance from the Boundary). 

3. Projected – creates a plane parallel to the X Y axis of the active workplane. The 

plane will have the Z Height of the highest point of the boundary. 
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Example 
• Delete the current model, toolpaths and boundaries. 

• Import the model:-  
                C:\users\training\PowerMILL_Data\Models\pockets.dgk 

 

 

 

 

 

 

 

 

 

 

 

 

• Define the Block to Min/Max limits. 

• Select the top surface of the model (shown shaded).  

• Create a User Defined Boundary, select the icon Model and then Accept 
the form. 

 

 

 

 

 

 

 

 

 

 

 

 

The boundary produced has 4 segments. For this example only the two smallest segments 

are required. 

 

• Select the two highlighted segments by dragging the cursor over them. 
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• Right click over Models in the explorer, and select Create Plane - 
Projected. 

 

 

 

 

 

 

Two planer, blanking Surfaces 

are created as shown. 

 

No need to Save the Project 

this time! 

 

 

 

 

 

 

• Select File- Delete All and Tools - Reset Forms. 
 

Exercise 
 

• From Examples, open the model bucket.dgk and generate 4 surface 
planes to cover the foot recesses on the upper base surface. 
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9. Feature sets / 2D machining 

Introduction 
 

PowerMILL has a range of 2D strategies which operate specifically on entities called 

Features. These are extruded along Z from wireframes (Pattern or imported model) and 

are assigned as specific types such as Boss, Pocket, Slot, Hole, etc. Features are machined 

independently (not gouge checked) to any existing surfaces/solids. A Feature is displayed as 

an upper and lower contour linked by vertical lines. A 2.5D Component is built up from a 

Feature Set consisting of one or more related Features. Milling will occur collectively in 

areas as dictated by the individual Feature types.  

 

1. Features  

Features are created from 2D geometry, and are individually defined as a Pocket, Slot, Boss 

or Hole. It is also possible to extract Hole features directly from a Surface or Solid model as 

well as from Area Clearance strategies when using the Drilling option for Lead In Moves. 

 

2. Area Clearance (2.5D machining strategies) 

On completion of a Feature Set, the 2.5D Area Clearance strategies are applied to create 

roughing, semi finishing, and finishing strategies. 

 

3. Drilling 

Drilling options can only be applied to Hole Features. Types of cycle supported include 

Standard drilling, Boring, Helical milling, Tapping and Thread Milling. 

 

Features 
There are six different types of Feature which respond specifically to the 2.5D Area 

Clearance options:- 

 

1. Pocket, relates to the area inside a Feature. Machining will occur inside the Feature. 

2. Slot, relates to the tool tracking along the Feature contour (with or without LH or RH 

cutter compensation). 

3. Boss, relates to the area outside the Feature. Machining will occur outside the Feature. 

4. Hole, this type of Feature is specifically used with Drilling strategies and can be defined 

from points, circles, curves, or directly from CAD model data. 

5. Circular Pocket - a circular pocket is defined from points, circles or curves. 

6. Circular Boss - a circular boss is defined from points, circles or curves. 

 

Note:  it is not possible to change an existing a Feature to one of a different type. 

Stacked 2D/3D data containing pairs of wireframe circles/curves/lines or cylindrical 

surfaces can be imported into PowerMILL to be directly defined as Hole features, thereby 

removing the need to manually input some or all of the dimensions. 
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Creating Features from Pattern segments 
 

• Select File ����Delete All and Tools ���� Reset forms. 

• Open the Project:-  
                 C:\users\training\PowerMILL_Data\Projects\2D-Drawing 

 
 
 
 
 
 
 
 
 
 
 
 
The imported Project contains a Pattern defining 2D geometry to be used to create a 

Feature Set. The Project is Locked to prevent it from being altered hence the first step is to 

Save As a separate Project locally with a different name. 

 

• Select File - Save Project As:- 
           C:\users\training\COURSEWORK\PowerMILL-Projects\2DPatternExample 

 

• In the explorer right mouse click on Feature Sets to access the local 
menu and select Create Feature Set. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• A new (empty) Feature Set - 1 will appear in the explorer and the 
Feature Form will open ready to build the 2.5D model. 

• Select the larger, rectangular Pattern Segment and enter values exactly 
as shown in the above right Feature Form before selecting Apply (Do not 
close the form). 
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The first Feature is the main component body defined as a Boss (as shown above). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select both, the filleted rectangle and the large circle Pattern Segments 
and enter values exactly as shown in the above left Feature Form before 
selecting Apply (Do not close the form). 

 
If the form is closed by mistake to reactivate on the same Feature Set - right mouse click on 

Feature Set named 1 in the explorer and in the local menu select Settings. 
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• Select all 12 of the Dia 6 circles and enter values exactly as shown in 
the above left Feature Form before selecting Apply. 

 
 
The contents of the Feature Set (1) should be similar to the illustration on 

the left (Note: The Author has opted to use a naming system where a Boss 

is prefixed with a b, a Pocket with a p, and a Hole with an h). 

 
The Feature Set is now complete and ready for the creation of suitable 

2.5D Machining Strategies. 

 
 
 
 
 
 

2D Feature Set Machining 
 

• Define a Dia 10 - tiprad 1 - Length 50 tool named D10T1. 
 

• In the Block form           set Type - Feature before selecting Calculate. 
 

 

• In the Rapid Move Heights form         select Calculate. 
 
 

• Open the Toolpath Strategies form        and select 2.5D Area Clearance. 
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• Select Feature Set Area Clearance and input data exactly as shown in 
the following form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate to process the toolpath and then Cancel the form. 
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• Select Feature Set Profile and input data exactly as shown in the 
following form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate to process the toolpath and then Cancel the form. 
 
 
 
Note the tool is plunging 

directly onto the form down Z. 

This situation will be changed 

retrospectively by applying 

appropriate options in the 

Leads and Links form. 
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• Select the Leads and Links form         and for Lead In - 1st Choice select 
Pocket Centre followed by Copy to Lead Out before selecting Apply.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Define a Dia 6 Drill - Length 50 and named Drill6. 
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• Open the Toolpath Strategies form        and select Drilling. 

• In the form select Drilling to open the form (below) and then click on the 
Select tab to open the Feature Selection form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Feature Selection form the Select tab is clicked to include all of the 
defined holes in the Feature Set. 

• Enter other data into the Drilling form exactly as shown above before 
selecting Calculate. 

• Close the Drilling and Hole Selection forms. 
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2D Machining Exercise 
 

For this exercise the following 2D drawing will be used.  

 
 

• Delete All and Reset forms  

• Import the 2D wireframe model (as shown above):- 
       C:\users\training\Powermill_Data\Models\2d_Wizard_Example.dgk  

 

• Create appropriate Feature Sets to the above drawing dimensions. 
  

1st Feature Set 

The outer square and small 

tapered, central upstand are 

created as Boss Features. 

 

The intermediate square is 

created as a tapered Pocket.  

 

The four Dia 15 circles are 

created as Hole Features. 

 

2nd Feature Set  

The Slot Feature is best created 

in a second Feature Set. 

 

 

 

• Create a Dia10 End Mill named Em10 (Roughing, Semi-finishing of 
main Pocket and Finishing of Slot Feature). 
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• Create a Dia 10 Tapered Tipped tool named D10Tr3A5, with Tip Radius 
3, Taper Angle 5Deg, Length 50, Taper Diameter 7.5 (Final Finishing 
of tapered walls Main Pocket and small Boss). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:- To calculate the Taper Height based on the Taper Angle and base Taper Diameter 

the Manual Input, icon   adjacent to the  Taper Height is clicked to apply the 

Calculate option   to this parameter.   

 
 
 
 
 
 
 
 
 
 
 



PowerMILL 2011                           9.  Feature sets /2D machining 

                                                                   Issue PMILL 2011                                                                         9.11 

• Create a Dia 15 Drill named Drill15. 

• Create suitable 2D machining strategies to produce an end result similar 
to that shown in the following ViewMill illustrations. 

 
Suggested Strategies:- 

 

Main Block and Central Pocket  
1/   EM10         - Feature Set Area Clear – Offset all 

2/   D10Tr3A5  - Feature set Profile  

3/   Drill15        - Drilling 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Slot will be machined independently from the main pocket and for this reason it is better 

to define it in a separate Feature Set. Note; The Y dimension of the existing Block will have 

to be adjusted to fully, include the Slot Feature. 

 

Slot 

1/   EM10  - Feature Set Profile  

 

 

 

 

 

 

 

 

 

Width of Slot is achieved by creating multiple 

toolpaths that use the 3 different Slot Cutting 

options starting with Centreline. 
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Creating Features from Model holes 
 

As well as being able to use imported 2D geometry, Hole Features can be automatically 

defined from selected Holes in the 3D Surface or Solid model. 

 

• Delete All and Reset forms. 

• Select File - Import Model:- 
                  C:\users\training\PowerMILL_Data\Models\corner_bowl.dgk 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

• Make sure the Block is not defined at this stage, as the top of the Hole 
Features will be created at the nearest Z dimension (Max or Min) of the 
Block. This is likely to result in some holes being created the wrong way 
up (It is however possible to reverse a Hole Feature). 

 

• Select the whole model. 

• Right click over Feature Sets and select Recognise Holes in Model. 
 
 
 
 
 
 
 

 
 
 
 
 

• Input data into the Feature form exactly 
as shown and select Apply. 
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• Calculate a Block defined by a Box around the model.  

• Undraw the model. 
 

 

 

 

A Hole Feature is created for 

each of the selected holes in 

the model (including the 

counter-bores). 

 

 

 

 

 

 

• Define suitable tools, then drill and counter bore the holes using the 
Drilling options. 

Hole Capping 
Hole Features can be used as the basis for capping holes in the model. If the intersection of 

the hole and the top face is non-planar, PowerMILL will try and cap the hole with a curved 

surface, matching the tangency of the surrounding surface. If it is not possible to create Hole 

features because the holes are not exact, circular sections then it will be necessary to follow 

the capping procedure in the Edit Boundaries chapter. 

Example 
The following example illustrates the process of capping cylindrical Hole Features defined 

from a 3D model. 

 

• Delete All and Reset Forms. 

• Import the model:- 
                    C:\users\training\PowerMILL_Data\ Block_with_holes.dgk 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 



9. Feature sets /2D machining                                                                     PowerMILL 2011 

9.14 Issue PMILL 2011   

• Calculate a Block defined by a Box around the model (In this case the 
Holes will be created upside down). 

• Select the whole model by holding down the left hand mouse button and 
dragging a box over it. 

 
Next Hole Features will be created from the model. 

 

 

 

• Select Recognise Holes in Model. 
 
 
 
 
 

 

The tops of the holes are defined as the 

shortest distance from the top or bottom 

of the material Block. 

If Hole Features are created to a different 

orientation from the natural Z Axis, They 

are assigned to a new Feature Set. A new 

Workplane is also created with the Z 

Axis aligned to the new Feature Set, 

Hole direction. 

 

 

In this case the holes are created upside down to illustrate the Reverse Holes editing option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Right click on Feature Set 1 and in the menu click Select All followed by 
Edit - Reverse Selected Holes. 
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• Finally, select the top surface, then in the explorer, right click over 
Feature Set 1 and select the Cap Holes option. 

 
The new cap Surfaces will be generated (Tangential to the selected top surface) in a new 

model called Capping Surfaces created along with a new level of the same name.  

 

 

• Click the light bulb to undraw Feature Set 1. 
 

• Expand Levels by clicking on the + symbol. 
 

• Click the light bulb to undraw main surfaces. 
 

The new capping surfaces may be created inside out (Surface Normals reversed). If 

required they can be selected and from the local surfaces menu Reverse Selected can be 

applied. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note; the Capping Surfaces are automatically assigned to the new Level for easy selection. 
 

• Click on the light bulb to draw the Block with holes level back on. 
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Creating Features from a 3D CAD Model 
• Delete All and Reset Forms. 

• Import - 2DExample.dgk from Examples. 
 
 

 

 

 

 

 

 

 

• Calculate a Block defined by a Box around the model. 

• Select the Two surfaces shown (below).  

• In the explorer right mouse click on Feature Sets and from the local 
menu select Create Feature Set. 

• Rename the Feature Set as Example2.   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In the Feature form input Name root - F1 and select Type Pocket. 

• Input Define top by - Top of Block and Define Bottom by - Minimum 
curve Z and Apply to create the Features. 

• Create a Dia 20 End Mill named EM20.  
 
 
 

From the 2 selected Surfaces a total of 5 

Features are created (2 large Pockets and 3 

circular Bosses).  
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• Select the Feature that does not include the 3 Boss Features. 

• From the Strategy Selector select the 2.5D Area Clearance tab. 

• Select Feature Set Profile and input data exactly as shown in the 
following form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Apply and Cancel the form. 
 

 

 

 

 

 

 

 

 

 

 

 

 

• Save the Project as:- 
                  C:\users\training\COURSEWORK\PowerMILL-Projects\2Dtest 

 

• Do not close the Project as it is to be continued in the next section. 
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Area Clearance Cutter Compensation 
There is an additional option for applying Cutter Compensation to a toolpath available from 

the Expert area of the Area Clearance dialog. 

 

• Activate the Toolpath Pocket-2DFin 

• Select Settings to open the toolpath form and then select the make a 
Copy option. 

• Rename the Toolpath as Pkk1-2DFin_FullRadComp 

• With the Feature Set Profile strategy form active select the Cutter 
Compensation page (as shown below) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Make sure the CNC cutter compensation box is ticked, and set Type - 
Full radius with Minimum radius 0.1 

• Select the Leads and Links page and select  to open the main Leads 
and Links form. 

• Set Lead In/Out as Horizontal Arc left - Radius 10 - Angle 90 

• Set Extensions - Inward/Outward -  Extended Move 10 

• Accept the Leads and Links form. 

• Apply the main Feature Set Profile form. 
 
 
 
The effect of the Cutter Compensation is not 

visibly displayed in PowerMILL for this type of 

2D Strategy but is applied during post-

processing for the ncdata output file.   
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• Select the Settings of the toolpath and make a Copy. 

• Set the Cutter Compensation - Type to Wear and Recycle the toolpath. 
 
 
 
 
 
 
 
 
 
 
 
 

• Create a separate NC Program for each of the 3 strategies using a Heid 
option file 

 
Note:-  

The X Y positional cutting moves for the Full Radius compensation are dimensionally on the 

actual 2D Feature form. 

The X Y positional cutting moves for the Tool wear compensation, dimensionally relate to 

the tool centre position. The NCDate file includes an RL code to enable the operator to input 

small compensation values as required. 

Protected Cutter Compensation  
 
With Type Wear selected PowerMILL compensates for the nominal tool radius and the 

machine tool compensates for any difference. It corrects for the limitations of the Off option 

by ensuring that, in concave corners, a Minimum Radius field controls the size of the arc in 

corners after a tool radius offset. 

Most machine tools will then be able to accurately represent the contour in concave corners. 

This allows PowerMILL to use the nominal tool size to check for collisions, but last-minute 

corrections for the physical tool size can be applied on the machine. 

Protected compensation is naturally applied up to the radius of Active Tool. Provided the 

machinist does not use a compensation value (On the Machine tool controller) greater than 

the radius of the Active Tool use in PowerMILL, then potential gouging in the corners will 

be prevented. 

 

 
 
 
 
 
 
 
 
 

 (Protected) 
Toolpath Radius 
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Thread Milling 
 
Thread Milling is included as one of the Drilling options. 

If the Cycle Type - Thread Milling option is selected, the tool plunges 

centrally to a specified depth, leads on to the sidewall, and then 

pitches upwards before leading off. 

Within the options it is possible to apply a number of passes (stepping 

outwards by an allowance value) to avoid tool overload. It is also 

possible to choose either a Right Hand or Left Hand thread. 

 
 
 
 
 
 
 

• Select File ����Delete All and Tools ���� Reset forms. 

• Open the Project:-  
                     C:\users\training\PowerMILL_Data\Projects\ThreadMILL1-Start 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The imported Project basically contains a Cad model, a predefined Hole Feature, a 3D 

Offset Area Clearance strategy using a Tip Radius cutter, and a Thread Milling tool. The 

original Project is Locked to prevent it from being altered, hence the first step is to Save As 

a separate Project locally with a different name. 

 

• Select File - Save Project As:- 
         C:\users\training\COURSEWORK\PowerMILL-Projects\ThreadMILL-Example1 

 

• Activate the Thread Milling Tool named M40-Coarse-Pitch-5. 

• Activate the Pocket Feature around the centre wall of the component. 
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• Select Toolpath Strategies         and in the Strategy Selector form select 
Drilling. 

 
 
 
 
 
 
 
 
 
 
 
 
 

• In The Drilling form set the Cycle Type to Thread Milling, Radial 
Thickness -3, Pitch 5, Name M40-RH-Thread, leaving all other 
parameters as default (as shown below).   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Calculate the form to produce the Thread Mill toolpath and then Cancel. 
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• Create a new Block using Defined by Boundary along with Type 
model and Calculate to the exact component dimensions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Right click on the toolpath D50t6-RGH-a1 (Do not Activate it) and in the 
local menu select Simulate from Start.  

• Open a new ViewMILL session and run a simulation of both toolpaths. 
(Do not Activate either toolpath, so that the current Block definition is 
maintained). 
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PRO - 2D Machining Options 

Introduction 
 

PowerMILL Pro contains 4 new strategies designed for more efficient 2D Machining 

applications. These include:- 

 

1. Face Milling. 

2. 2D Curve Area Clearance. 

3. 2D Curve Profile. 

4. Chamfer Milling. 

2D Curve Machining Example 1  
 

• Select File ����Delete All and Tools ���� Reset forms. 

• Open the Project:-  
                   C:\users\training\PowerMILL_Data\Projects\Pro-2DMachiningStart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The imported Project contains 4 Tools and 3 Patterns defining the 2D geometry to be used 

in the 2D Machining options. The Project is Locked to prevent it from being altered hence 

the first step is to Save As a separate Project locally with a different name. 

 

 

 

• Select File - Save Project As:- 
              C:\users\training\COURSEWORK\PowerMILL-Projects\PRO-2DMachining 

 

• Activate the Pattern named CurveAll.  

• In the Block form, set Defined by - Box followed by Type - Active 
Pattern and select Calculate (Do not close the form).  
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• In the Maximum Z Coordinate box input 22 before selecting Accept to 
close the form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• In Rapid Move Heights click on Reset to Safe Heights. 

• Activate the Face Milling tool named D50T6. 

• From the 2.5D Area Clearance options select Face Milling and enter data 
into the form exactly as shown below. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

• Select Calculate to process the toolpath. 
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• Activate the Tip Radius tool named D16T3. 

• From the 2.5D Area Clearance options select 2D Curve Area Clearance 
and enter data into the form exactly as shown below. 
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• Select the Cut distances page and input Stepdown 10. 
 
 
 
 
 
 
 
 
 
 
 
 
 

• From the main Curve Area Clearance page, Curve options, select 
Interactively modify machinable sections. 

 
These options enable the user to have full control of direction of cut and the areas to be 

machined. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: While the Curve Area Clearance form is open, the areas to be machined are displayed 

as a shaded preview. 

 

• Select the Green Tick to exit the Edit Machining Sections toolbar. 

• Select Calculate to process the toolpath and then Cancel the form. 
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• Activate the End Mill named EM16. 

• From the 2.5D Area Clearance options select 2D Curve Profile and enter 
data into the form exactly as shown below. 

 
 
 
 
 
 
 
 
 
 

• Select the Cut distances page and input Stepdown 25. 
 

 

 
 
• Select Calculate to process the toolpath and then Cancel the form. 
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• Activate the End Mill named D25TrA45. 

• From the 2.5D Area Clearance options select Chamfer Milling and enter 
data into the form exactly as shown below. 

 
 
 

 

 

 

 

 

Set Curve position to 

Bottom 
 

 

 

 

 

 

 

 

 
 

 

Set Bottom axial depth 
 

 

 

 

 

 

• Select the Cut distances page and input Number of cuts 1. 
 
 
 
 
 
 

• Select Calculate to process the toolpath (Do not close the form). 
 
 
The resultant Chamfer 

Milling strategy has 

appeared on the wrong side 

of the Pattern. 

 

The toolpath needs to be 

recycled with the Chamfer 

Milling tool tracks changed 

to appear on the inside of 

the Pattern segments. 
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• In the Chamfer Milling form, select the Recycle icon to enable changes 
to be made to the above strategy. 

• Select the Interactively modify machinable sections icon to access the 
Edit Machinable Sections toolbar. 

• Select the Reverse machining side option, followed by the green tick to 
accept the changes and close the toolbar. 

 
 
 
 
 
 
 

• In the main Chamfer Milling form, Select Calculate to process the 
toolpath (Do not close the form). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Chamfer Milling options selected result in the angled part of the tool overlapping the 

base of the Chamfer by 1mm.  

 

 

 
 
 
 
 
 
 
 

A surface model of the finished component has been imported to provide a visual check of 

the Chamfer Machining. The 1mm tool overlap at the base of the chamfer is clearly visible 

in the above illustrations. 
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• Run a ViewMILL simulation of the whole machining process. 
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2D Curve Machining Example 2 – Inc. Clamp Avoidance  
 

• Select File ����Delete All and Tools ���� Reset forms. 

• Open the Project:-  
                   C:\users\training\PowerMILL_Data\Projects\2DCurveProfileEX2-Start 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The imported Project also contains a Dia16 End Mill and a Pattern defining the 2D 

geometry used in the existing 2D Machining Strategy. The Project is Locked to prevent it 

from being modified, hence the first step is to Save As a separate Project locally with a 

different name. 

 

• Select File - Save Project As:- 
              C:\users\training\COURSEWORK\PowerMILL-Projects\2DCurveProfileEX2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• In the Viewing toolbar ensure that Wireframe         view is on.  
 

The existing preliminary, Toolpath machines away the area where the clamps are located 

ready for the remaining strategies. 
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• Select an Iso1 view and perform a ViewMILL simulation on the existing 
toolpath. 

 
 
The existing preliminary, toolpath 

(MC-ClampArea-1) requires the 4 

clamps to be positioned midway 

along the sides and ends.  

 

Once this machining operation has 

been performed, the clamps are then 

moved to the same position as 

defined by the wireframe Model. 

 
 
 
 
 

• Select the No Image  option in the ViewMILL toolbar and disconnect 

ViewMILL  from the simulation process (Toggle the Sphere from 
Green to Red) 
 

• Select a View from top (Z). 
 

• Undraw all entities except the Block and the Pattern (OuterForm). 
 

 
 
 
 
 
 
 
 
 
 
 
The above  Pattern segment was created by using Insert - Model with the required 

wireframe segment.selected. The same Pattern will be used in the creation of the next 

Toolpath. 

 

• From the main pulldown menus select:- 
 Draw - Cursor - Cross Hair (Ctrl H) and Draw - Cursor - Tool (Ctrl T). 

 
This will provide an essential visual aid while defining the parts of the toolpath Pattern to be 

machined. Note: Alternative Shortcut options are shown in brackets. 
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• With the toolpath (MC-ClampArea-1) activated select Settings (local 
menu) to open the existing Curve Profile form. 

• At the top left corner of the form select the ‘Make a Copy’ option. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Rename the new toolpath as MC-ClampArea-2. 
 
 
 

Note:-The Tool Dia and Cross 

Hairs are displayed on the 

cursor. This will provide an 

essential visual aid while 

snapping new break points along 

the Pattern. 
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• Select  to open the Curve toolbar. 
 
 
 
 
 
 
The sections of the Pattern 

included in the original toolpath 

are displayed, along with the 

user defined, Start (green) and 

End (red) points. 

 
 
 
 
 
 
 

• Using the left hand mouse button (With the cursor visually assisted by 
the displayed Tool and Cross Hairs) reposition the Start and End points 
along the Pattern as shown below. 

 
 
 
 
 
When defining the Start and 

End points along the Pattern 

allow room for suitable Lead 

moves. 

 

 
 
 
 
 
 
 
 

 

• Select the green tick to accept the ‘user defined’ toolpath segments. 

• Select Calculate in the main Curve Profile form to create the toolpath. 

• Select OK to lose the Curve Profile form. 

• Use toolpath Simulation to visually check that the tool does not clash 
with the clamp profiles. 
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• Reconnect the ViewMILL session (Green Sphere) and visually check that 
the new toolpath is not missing any material where the original toolpath 
overlaps. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2D Curve Machining Example 2 – Without Clamp Avoidance 
 
• With the toolpath (MC-ClampArea-2) activated select Settings (local 

menu) to open the existing Curve Profile form. 

• At the top left corner of the form select the ‘Make a Copy’ option. 

• Select  to open the Curve toolbar. 
 
 
 
 
 
The sections of the Pattern 

included in the original toolpath 

are displayed, along with the user 

defined, Start (green) and End 

(red) points. 

 

 

 

 

• To return the machining range to include the whole Pattern, click on 

Remove selected machining sections  (Note: This is the default 
setting). 
 

• Select Mark all segments for machining. 
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If the Curve Profile strategy is used 

from scratch, the Mark all sections for 

machining option must be selected to 

provide full control over which side and 

sections of the Pattern are to be 

machined.  

Note the machining preview shows that 

the wrong side of the curve is currently 

selected (yellow sphere). 

 

 

• Select the Reverse machining side option.  

• Select the green tick to accept the ‘user defined’ toolpath segments. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate in the main Curve Profile form to create the toolpath. 

• Select OK to close the Curve Profile form. 
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This time the whole Pattern is used to define the range of the machining. This is the default 

option when Mark all sections for machining  is selected followed immediately by the 

Green tick.  
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10. Tool Holder Collision 
Checking 

Collision Checking 
 

Collision Checking can be applied retrospectively, as long as a tool Shank and Holder are 

defined with the Active Tool. If the option Verify - Collisions is applied, two additional 

toolpaths will be created from the original, one being collision safe, and the other being in 

collision. At the same time a copy of the Tool with a suitably extended Overhang will be 

substituted into the Original and Collision status toolpaths. 

 

• Select File - Delete all and Tools - Reset Forms from the top menu. 

• Import the model:-  
             C:\Users\training\PowerMILL_Data\Models\cowling.dgk 

 

• Calculate the Block to Min/Max limits. 

• Reset Rapid Move Heights and the tool Start and End Point. 

• Create a Dia 5mm Ball Nose tool Named BN5 with a Length of 10 and Tool 

Number 1. 
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• Select the Shank tab. 

• Select Add a shank component.  

• Fill in the form exactly as shown in the image below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select the Holder tab. 

• Select Add holder component.  

•  Fill in the form for the first Holder element exactly as shown in the image below. 

 
A picture of the current active 

Tool is displayed on the right 

hand side of the dialogue. 

Upper Diameter – the 

diameter at the top of the 

current section of the tool 

Holder. This must be greater 

than or equal to the Lower 

Diameter. 

Lower Diameter – the 

diameter at the bottom of the 

current section of the tool 

Holder. This must be less 

than or equal to the Upper 

Diameter. 

Length – the vertical height 

of the current Holder 

element. 

Overhang – the length of the 

cutter protruding from the 

base of the Holder. 
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• Select Add holder component. 

• Enter an Upper Diameter of 22, a Lower Diameter of 20 and a Length of 10. 
 

• Select Add holder component. 

• Enter an Upper Diameter of 30, a Lower Diameter of 30, a Length of 10 and 

an Overhang of 15. 

• Select Save tool holder  in C:\Temp with a File name as ToolHolder 

1.pmlth. 
 

If it is required to modify or 

delete a Holder element, select 

(left click) on one of them in 

the assembly illustration and it 

will turn pale. The current 

values for that element will be 

displayed and available for 

modification. 

The same procedure applies to 

modify Shank elements. 

 

After creating the tool Holder 

you save it. It can then be 

loaded at a later date to check 

further toolpaths for collisions 

if required. 

 

 

 

 

 

• Select Close.  

• Select Toolpath Strategies           on the main toolbar. 

• From the Finishing options select a Raster Finishing strategy. 
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• Enter a Name as RasterFinish, an Angle of 45 and Stepover of 1.     

• Select Lower Left as the Start Corner. 

• Select Leads and Links.  

• In the Leads and Links dialog box, select the tab Lead In and set the 1
st
 and 2

nd
 

Choices to None. 

• Do exactly the same in the Lead Out tab. 

• In the Leads and Links dialog box select the Links tab, enter a Short/Long 

Threshold of 2, set Short to Circular Arc and Long to Skim. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Calculate to process the toolpath and then select Cancel. 

 
 

 
 
 

The new, gouge free, Toolpath is 

generated but at this stage no collision 

checking has been applied in relation to 

the Shank and Holder. 
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• From the Main toolbar select Toolpath Verification. 
 

The two Check options here are Collisions and Gouges. 

Scope contains options to control which actual elements 

of a toolpath are checked. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shank Clearance and Holder Clearance, allows the 

user to specify a value for an additional, safe thickness 

around the tool Shank and Holder elements. 

 

 

 

 

 

• For both Shank Clearance and Holder Clearance input 1. 

• Select Apply. 

• Select OK. 
 

In this case PowerMILL has detected that 

with the current tool Holder and Shank 

settings collisions will be present at a 

depth of 6mm. A suggested tool 

Overhang of 21mm will be required to 

avoid this. 

 

• Select Accept on the Toolpath Verification form. 

 
 
PowerMILL has created two new toolpaths, BN5-Raster 

Finish_1 and BN5-RasterFinish_2. A new tool named 

BN5_1 has also been created in the tools area of the 

explorer. This new tool has been created with the new 

valid adjustments made i.e. Overhang 21. 
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• Activate the toolpath RasterFinish_1 in the Explorer. 
 

 

 

This toolpath only contains segments of the 

original toolpath, RasterFinish, that do not 

have any collisions so the original tool and tool 

holder, BN5 is still associated with it. 

If your preference is to run with the shorter 

overhang then you could run this toolpath on 

these areas shown. 

 

 

• Activate the toolpath RasterFinish_2 in the Explorer. 

 
 

 

 

 

This toolpath contains segments of the original 

toolpath that can only be machined with the newly 

adjusted tool Overhang. 

 

 

 

 

 

• Activate the original toolpath RasterFinish in the Explorer. 
 

       

 

PowerMILL has replaced the newly created Tool 

BN5_1 (with an extended overhang) into BN5-

RasterFinish and BN5-RasterFinish_2. 

 

 

 

• Select File - Save Project As:–  
        C:\users\training\COURSEWORK\PowerMILL-Projects\ToolCollisionExample 
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Pro - Tool Holder Collision 
Checking 

Automatic Collision Checking 
In PowerMILL Pro, Tool Holder Collision Checking can be applied during Toolpath 

calculation. 

If the Toolpath is calculated using a tool that includes a Shank and Holder any part of the 

toolpath segments that would otherwise be in a collision condition will not appear. These 

missing segments can then be machined later using a modified Tool in conjunction with a 

Collision Safe Boundary. 

 

• Select File - Delete All and Tools - Reset Forms. 

• Open the Project:- 
               C:\users\training\PowerMILL_Data\Projects\ToolCollision_Start 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select OK on the PowerMILL Warning form. 

• Save Project As:-   
         C:\users\training\COURSEWORK\PowerMILL-Projects\ToolCollisionPro_1 

 

• Right click on the toolpath RasterFinish in the explorer. 

• From the local menu select Activate followed by Settings and in the 
Raster Finishing form select the Copy toolpath icon. 
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• With the Raster Finishing form open, select the Automatic Verification 
page         to open the following form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Tick the box Automatic collision checking and for both Shank 
Clearance and Holder Clearance input 1.0.  

• Calculate the Raster Finishing form to directly create a collision free 
toolpath, RasterFinish_1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:- This method does not inform the user a of a recommended new Shank length for the 

missing area or automatically create a new compatible tool (BN5_1).  
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Collision Safe Boundary 
 

A toolpath for the remaining areas will require a new Dia 5 Ball Nosed tool with increased 

Shank length. The additional Toolpath will be calculated to limits set by a Collision Safe 

Boundary based on the current tool (bn5). 

 

• Ensure that the tool BN5 is Active. 

• In the explorer right mouse click over Boundaries and in the local menu 
select Create Boundary - Collision Safe. 

 
 
 
 
 
 
 

• Apply the form. 
 
The lower part of the central pocket is more suited to be finish machined using an End Mill. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select and Delete the 2 segments in the central pocket and the outer one. 
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• In the explorer right mouse click over the Tool - BN5 and from the local 
menu select Edit - Copy Tool (to create BN5-1). 

 
 
 
 

• Right mouse click over the new tool BN5-1 and from the local menu select 
Activate followed by Settings.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• In the Tool Definition form select the Holder tab and change the 
Overhang value to 25.0 before selecting Close. 

• Right click on the toolpath RasterFinish_1 in the explorer. 

• From the local menu select Activate followed by Settings and in the 
Raster Finishing form select the Recycle toolpath icon. 

• Activate the new ‘long reach’ Tool BN5_1 
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• Select the Limit page and select Boundary 1 with Trimming - Keep 
inside. 

 
 
 
 
 
 
 
 

• Keep the previously used Automatic verification settings. 

Note that Automatic Collision Checking is still active and as can be seen in the above 

illustration there is no evidence of the toolpath being fragmented.  
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